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Documentation Conventions

Typographic Conventions
The names of keyboard keys are set in sans serif type and encased in
double angle brackets:

ExampleExampleExampleExampleExample «Proceed»

Items in programming menus are italicized:

ExampleExampleExampleExampleExample Select Edit from the Main Menu.

Graphic Conventions
The programming screens displayed in the LCD window are represented
by a box containing four lines of text:

ExampleExampleExampleExampleExample

Terminology
A programming option is termed “selected” when the cursor is positioned
in front of it. Use the «Select» keys (see fig. 2-2) to move the cursor. In
some screens selected items are also displayed in all-capital letters.

Run: 2-STEP

 1=  92.0  for 0:05

Cycle:  1

Calc:  65.0
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Meet the DNA Engine
Thank you for purchasing an MJ RESEARCH PTC-200 DNA Engine. De-
signed by a team of molecular biologists and engineers, the DNA Engine
will meet your needs for a versatile, easy-to-use, reliable, and compact
programmable thermal cycler:

• Interchangeable sample blocks—the Alpha unit family— that accom-
modate many types of tubes, microplates, and slides

• Hot Bonnet heated lid (or its remote-controlled version, the Power Bon-
net) for oil-free cycling

• Intuitive software with easy-to-read interface for quick and painless
programming, editing, file management, password protection, and
much more

• Choice of calculated sample temperature control for highest speed
and accuracy, or block or probe control for compatibility with proto-
cols designed for a variety of instrument types

• Space-saving design for easy setup and transportation

• Instant Incubate feature for continuous-temperature incubations

• Networking for up to 15 machines, for convenient remote operation
and documentation of runs

• Customizable factory-installed protocols

When multiple users or high-throughput operations must be accommo-
dated, the PTC-225 DNA Engine Tetrad is available. Essentially consist-
ing of four DNA Engines placed in one chassis, the DNA Engine Tetrad
has the same features and ease of use of the stand-alone DNA Engine.

Using This Manual
This manual contains all the information you need to operate your DNA
Engine or DNA Engine Tetrad safely and productively:

• Chapter 2 acquaints you with the physical characteristics of the DNA
Engine.

• Chapters 3–5 present the basics of installing and operating the DNA
Engine.

• Chapters 6 and 7 describe programming the DNA Engine.

• Chapter 8 outlines the utilities available for the DNA Engine.

• Chapter 9 describes how to network and remotely operate the DNA
Engine and DNA Engine Tetrad.
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Introduction

• Chapter 10 explains the proper maintenance of the DNA Engine.

• Chapter 11 offers troubleshooting information for the DNA Engine.

• Chapter 12 describes the operation of the DNA Engine Tetrad.

• Chapter 13 describes the operation of the RAD–0200 Remote Alpha
Dock accessory.

Important Safety Information
Safe operation of the DNA Engine or DNA Engine Tetrad begins with a
complete understanding of how the machine works. Please read this en-
tire manual before attempting to operate the DNA Engine or DNA En-
gine Tetrad. Do not allow anyone who has not read this manual to oper-
ate the machine.

The DNA Engine and DNA Engine Tetrad can generate enough heat to
inflict serious burns and can deliver strong electrical shocks if not used
according to the instructions in this manual. Please read the safety warn-
ings and guidelines in appendix A, and exercise all precautions outlined
in them.
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Layout and Specifications

Front View,   2-2
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Bottom View,   2-3

Alpha Units,   2-4
Single-Block Models,   2-4

Dual-Block Models,   2-4
Slide Block,   2-4

Power Bonnet Accessory,   2-4
Specifications,   2-5
Gradient Specifications,   2-6
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Front View
(Figure 2-1)

Control Panel
(Figure 2-2)

Air exhaust vents
(also on other side)
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Layout and Specifications

Back View
(Figure 2-3)

Bottom View
(Figure 2-4)

Air intake vents

Power cord jack

Alpha unit  handle

Alpha unit
Air exhaust vents
(also on other side)

IEEE-488 port

Parallel printer port

RS-232 port

Back Front

Air intake vents
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Alpha Units

Single-Block Models
60V Alpha: Holds 60 x 0.5ml tubes

96V Alpha: Holds 96 x 0.2ml tubes or one 96-well
microplate

192 Alpha: Holds one 192-well microplate

384 Alpha: Holds one 384-well microplate or
one 96-well microplate

Dual-Block Models
30/30 Dual Alpha: Holds 2 x 30 x 0.5ml tubes

30/48 Dual Alpha: Holds 1 x 30 x 0.5ml tubes
and 1 x 48 x 0.2ml tubes

48/48 Dual Alpha: Holds 2 x 48 x 0.2ml tubes or
half plates

Slide Block
Twin Tower: Holds 2 x 16 standard slides

Power Bonnet Accessory
Permits remote control of Alpha unit lid opening; avail-
able for Alpha models 96V and 384.
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Layout and Specifications

Specifications
Thermal range: –5˚ to 105˚C, but no more than 30˚C below ambient

temperature

Accuracy: ±0.3˚C of programmed target @ 90˚C, NIST-traceable

Thermal homogeneity: ±0.4˚C well-to-well within 30 seconds of arrival at
90˚C (for most Alpha units; see specifications for in-
dividual Alpha units)

Ramping speed: Up to 3˚C/sec for all single- and dual-block Alpha
units; 1.2˚C/sec for the Twin Tower

Sample capacity: Varies with installed Alpha unit

Line voltage: 100–240VAC rms (no adjustment needed among volt-
ages within these ranges)

Frequency: 50–60Hz single phase

Power: 850W maximum

Fuses: Two 6.3A, 250V, 5 x 20mm

Displays: One 20 x 4 LCD alphanumeric display

Ports: One 25-pin 8-bit parallel interface printer port

One 9-pin RS-232 serial port for printer or remote use

One IEEE-488 bidirectional general purpose interface
bus

Memory: 200 typical programs in up to 12 individual folders

Weight: 7.6–9.3kg, varies with installed Alpha unit (DNA
Engine Tetrad: 29kg, including Alpha units and
power supply)

Size: 24 x 35 x 17cm (DNA Engine Tetrad: 37 x 55 x 25cm)



Gradient Specifications (96V Alpha module only)
Accuracy: + 0.4°C of programmed target at end columns, 30

seconds after the timer starts for the gradient step,
NIST–traceable

Column uniformity: + 0.4°C , well–to–well within column, within 30 sec-
onds of reaching target temperature

Calculator accuracy: + 0.4°C  of actual well temperature

Lowest programmable 30°C
temperature

Highest programmable 105°C
temperature

Temperature differential 1–24°C
range
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Installation

Packing Checklist,   3-2

Setting Up the DNA Engine,   3-2
Environmental Requirements,   3-2

Power Supply Requirements,   3-3
Air Supply Requirements,   3-3

Ensuring an Adequate Air Supply,   3-3
Ensuring That Air Is Cool Enough,   3-4

Requirements for Robotics Installations,   3-5
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Packing Checklist
After unpacking the DNA Engine, check to see that you have received
the following:

• One DNA Engine base

• One Alpha unit (more if additional units were ordered)

• Two spare fuses

• One power cord

• One probe, if purchased

• PTC-200 DNA Engine & PTC-225 DNA Engine Tetrad Operations Manual
(this document)

• Product registration card (US customers only)

• Extended warranty application (US customers only)

• DNA Engine Driver remote software request form

If any of these components are missing or damaged, contact MJ RESEARCH

or the authorized distributor from whom you purchased the DNA En-
gine to obtain a replacement. Please save the original packing materials
in case you need to return the DNA Engine for service. See appendix E
for shipping instructions.

Setting Up the DNA Engine
The DNA Engine requires only minimal assembly: plugging in the power
cord and inserting an Alpha unit. Insert the power cord plug into its jack
at the back of the machine (see fig. 2-3 for location of jack), then plug the
cord into an electrical outlet. With the machine turned off, insert an Alpha
unit (see “Installing an Alpha Unit,” chapter 4).

Caution:Caution:Caution:Caution:Caution: Do not insert or remove an Alpha unit with the DNA
Engine turned on; electrical arcing can result. Read the
safety warning in appendix A regarding electrical safety
when inserting or removing an Alpha unit.

Environmental Requirements
Ensure that the area where the DNA Engine is installed meets the follow-
ing conditions, for reasons of safety and performance:

• Nonexplosive environment

• Normal air pressure (altitude below 4000m)
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Installation

• Ambient temperature 5˚–31˚C

• Relative humidity up to 90%

• Unobstructed access to air that is 31˚C or cooler (see below)

• Protection from excessive heat and accidental spills (Do not place
the DNA Engine near such heat sources as radiators, and protect it
from danger of having water or other fluids splashed on it, which
can cause shorting in its electrical circuits.)

Power Supply Requirements
The DNA Engine requires 100–240VAC, 50–60Hz, and a grounded out-
let. The DNA Engine can use current in the specified range without
adjustment, so there is no voltage-setting switch.

Power cords for outlets other than the US 120V outlet may be purchased
from computer stores, since they are also used for most desktop computers
and printers and meet international standard IEC-320. The power cord must
be rated to carry at least 10A at 125V or 250V, depending on the voltage
available in your nation. The quality of the power cord can be further en-
sured by making certain it is inscribed with the trademark of UL, CSA, TUV,
VDE, or another national testing agency.

NNNNNote:ote:ote:ote:ote: Do not cut the supplied 120V power cord and attach a different con-
nector. Use a one-piece molded connector of the type specified above.

Air Supply Requirements
The DNA Engine requires a constant supply of air that is 31˚C or cooler in
order to remove heat from the Alpha unit’s heat sink. Air is taken in from
vents at the front, back, and bottom of the machine and exhausted from
vents on both sides (see figs. 2-1, 2-3, and 2-4). If the air supply is inadequate
or too hot, the machine can overheat, causing performance problems, soft-
ware error messages (particularly “HS Overheating” and “Slow Block Cy-
cling”), and even automatic shutdowns. Special attention should be paid to
airflow and air temperature in robotics installations of DNA Engines.

Ensuring an Adequate Air Supply
• Do not block the air intake vents.

Position the DNA Engine at least 10cm from vertical surfaces and
other thermal cyclers (greater distances may be required; see be-
low). Do not put loose papers under the machine; they can be sucked
into the air intake vents on the bottom of the machine.
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• Do not allow dust or debris to collect in the air intake vents.

The bottom air vents are particularly liable to collect dust and debris,
sometimes completely clogging up. Check for dust and debris every
few months, and clean the intake vents as needed. Remove light col-
lections of dust with a soft-bristle brush or damp cloth. Severe col-
lections of dust and debris should be vacuumed out. Turn the ma-
chine off prior to cleaning or vacuuming air vents.

Ensuring That Air Is Cool Enough
• Do not position two or more DNA Engines (or other thermal cyclers)

so that the hot exhaust air of one blows directly into the air intake
vents of another.

• Make sure the DNA Engine receives air that is 31˚C or cooler by mea-
suring the temperature of air entering the machine through its air
intake vents.

Place the DNA Engine where you plan to use it, and turn it on. Try to
reproduce what will be typical operating conditions for the machine
in that location, particularly any heat-producing factors (e.g., nearby
equipment running, window blinds open, lights on). Run a typical
protocol (e.g., 2-Step) for 30 minutes to warm up the DNA Engine,
then measure the air temperature at the back air intake vents. If more
than one machine is involved, measure the air temperature for each.

If the air intake temperature of any machine is warmer than 31˚C,
use table 3-1 to troubleshoot the problem. Some experimentation
may be required to determine the best solution when more than one
cause is involved. After taking steps to solve the problem, verify that
the temperature of the air entering the air intake vents has been low-
ered, using the procedure outlined above.

Table 3-1  Troubleshooting Air Supply Problems
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Requirements for Robotics Installations
Robotics installations require special attention to airflow and air tempera-
ture. Typically in these installations, DNA Engines and other thermal cy-
clers are crowded into a small area, along with other heat-generating equip-
ment. Overheating can quickly occur when many of these machines are
operating at once, unless preventive measures are taken.

Follow the procedures described above to ensure adequate airflow and
an air intake temperature of 31˚C or cooler. Air intake temperature must
be verified by measurement.

Do not use oil to thermally couple sample vessels to the blocks of ma-
chines in a robotics installation. Oil makes plates difficult to remove.
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Turning the DNA Engine On
Move the power switch to “1” (the “On” position). In most The fan will
turn on, and the power light on the keyboard will glow red.  In most
cases a self-test of the heat pumps will begin running (see note below).
Its progress is tracked on a screen in the LCD window:

This screen disappears in 1 minute. If a problem is detected, the display
shows an error message.

Note:Note:Note:Note:Note: If the Alpha unit’s block or heat sink is not at ambient tempera-
ture (typically because the Alpha unit was recently in use), the machine
will skip the self-test.

If the self-test does not detect any problems, the Main Menu is displayed:

The DNA Engine is now ready to execute programs.

Understanding the Main Menu
The Main Menu is the common access point to all programming and
machine configuration screens:

• Run: Executes a program.

• Enter: Allows new programs to be entered.

• List: Accesses utilities that display or print a program’s steps.

• Edit: Allows modification of stored programs.

• Files: Accesses file management utilities.

• Setup: Accesses machine and networking configuration screens.

PTC-200:

    Self testing

.

PTC-200:

_RUN       Enter

 List      Edit

 Files     Setup
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Using the Control Panel
The control panel (see fig. 2-2) includes operation keys, status indicator
lights, an LCD window for displaying programming and machine status
text, and a numeric keypad for entering values into programs.

Operation Keys
• Select keys (left and right arrows): Move the cursor one space or op-

tion to the left or right in the LCD window; display time and cycle
information during a protocol run.

• Proceed: Accepts a selected menu or screen option; during a protocol
run, advances the program to its next step.

• Cancel: Terminates a running protocol; during program creation or
editing, cancels the last entry.

• Stop: Terminates a running protocol.

• Pause: Pauses a protocol during execution; accesses Japanese Katakana
syllabary.

• Instant Incubate: Initiates a program that sets up the DNA Engine as
a simple incubator.

• Block: Selects a different block when using a dual-block Alpha unit;
switches between block screens and the Main Menu in the LCD win-
dow during a protocol run.

Status Indicator Lights

• Power light: Glows red when the DNA Engine is powered up.

• Block Status lights: Indicate which blocks are in use; glow red when
blocks are heating and green when blocks are cooling.

Using the Data Ports
The DNA Engine has three data ports located at the rear of the machine:
an RS-232 port, an IEEE-488 port, and a parallel (printer) port. See chap-
ters 8 and 9 for information on using these ports to network machines,
connect them to a computer, or print data.
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Operating Alpha Units

Note:Note:Note:Note:Note: Operation of the Twin Tower will not be discussed, owing to the
many differences between this type of Alpha unit and the others. Please
see the Twin Tower Block Operations Manual for operating instructions.

Note:Note:Note:Note:Note: Alpha units equipped with Power Bonnets are installed and removed
as described below. See the Power Bonnet User’s Manual for instructions on
opening and closing Alpha units with Power Bonnets.

Installing an Alpha Unit
1. Turn the DNA Engine off (see the Caution on p. 4-5).

2. Hold the Alpha unit at its front and back edges.

3. Lower the Alpha unit into the DNA Engine base, leaving at least 3cm
between the front edge of the Alpha unit and the front of the base.

4. Raise the handle at the back of the Alpha unit, and slide the block
forward as far as it will go (fig. 4-1A).

5. Push the handle down until it is completely vertical (fig. 4-1B); firm
pressure may be required. A definite click signals that the Alpha unit’s
connectors have mated with the DNA Engine’s connectors.

When the handle is in the down position, the Alpha unit is locked into place.

AAAAA BBBBB

Figure 4-1       Installing an Alpha unit.
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Removing an Alpha Unit
1. Turn the DNA Engine off (see the Caution below).

2. Pull upward on the handle. When the lock releases, you will hear a
click, and the Alpha unit will slide a little toward the back of the DNA
Engine. The electrical connectors of the Alpha unit and the DNA En-
gine are now disengaged, so there is no danger of electrical shock.

3. Slide the Alpha unit toward the rear of the DNA Engine about 3cm.

4. Grasp the front and back edges of the Alpha unit, and lift it out of
the machine.

Caution:Caution:Caution:Caution:Caution: Do not insert or remove an Alpha unit with the DNA
Engine turned on; electrical arcing can result. Read the
safety warning in appendix A regarding electrical safety
when inserting or removing an Alpha unit.

Opening an Alpha Unit
Grip the front edge of the top lever of the Hot Bonnet as shown in figure
4-2A, and pull upward firmly. The top lever will pop open to reveal the
entire thumbwheel (fig. 4-2B). Continue pulling upward to open the Hot
Bonnet. The Hot Bonnet will tip backward, revealing the entire block.

Caution:Caution:Caution:Caution:Caution: Do not pull on the thumbwheel to open the unit. This can
damage the Hot Bonnet’s closing mechanism.

MJRESEARCH

PTC-200Peltier Thermal Cycler

DNAEngine

Power

Instant Incubate Block Display

B
A Block StatusHeating        Cooling

CAUTION:  Sample block(s) may be very hot !
ATTENTION:  Les blocs peuvent erte tres chauds !

Pause
Stop

Cancel

Proceed

Select

MJRESEARCH

PTC-200Peltier Thermal Cycler

DNAEngine

Power

Instant Incubate Block Display

B
A Block StatusHeating        Cooling

CAUTION:  Sample block(s) may be very hot !
ATTENTION:  Les blocs peuvent erte tres chauds !

Pause
Stop

Cancel

Proceed

Select

AAAAA BBBBB

Figure 4-2       Opening an Alpha unit.
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Closing an Alpha Unit
Press down on the top lever. The lever will close down over the thumbwheel
as the Hot Bonnet closes down over the sample block. A click signifies that
the Hot Bonnet’s latch has engaged.

Selecting the Correct Sample Vessel
The DNA Engine’s wide variety of interchangeable Alpha units affords
you great scope in choosing sample vessels. Keep in mind that differ-
ences in tube and plate composition and wall thickness among the many
brands available can affect reaction performance. Protocols may require
some adjustment to ensure optimum performance when using a new
vessel type. MJ RESEARCH offers a full range of tubes and microplates,
manufactured to the specifications of each type of Alpha unit to ensure a
precise fit. See chapter appendix 4-A for a complete list.

0.5-ml Tubes
Make sure thick-walled 0.5-ml tubes fit the wells snugly. Since these tubes
were originally designed for centrifuges, some brands may not fit tightly
in thermal cycler wells. Thin-walled 0.5-ml tubes were specifically de-
signed for thermal cycling, and the higher quality brands provide a good
and consistent fit. MJ RESEARCH provides thin- and thick-walled 0.5-ml
tubes designed for precise block fit.

0.2-ml Tubes
All types of thin-walled 0.2-ml tubes may be used. MJ RESEARCH sells
high-quality 0.2ml tubes in a number of styles, including individual tubes
and strips.

Microplates
A variety of 96-well polycarbonate or polypropylene microplates can be
used in 96V Alpha units as long as they fit the wells snugly. Polypropy-
lene microplates are usually preferred because they exhibit very low pro-
tein binding and, unlike polycarbonate microplates, do not lose water
vapor through the vessel walls. This allows smaller sample volumes to
be used—as little as 5–10µl. Polypropylene microplates and compatible
Microseal ‘A’ film, mats, or strip caps for sealing are available from MJ
RESEARCH. (See “Sealing with the Hot Bonnet and Caps or Film Sheets,” p.
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X, for a description of Microseal ‘A’.)

Thin-Walled Vs. Thick-Walled Tubes
The thickness of sample tubes directly affects the speed of sample heat-
ing and thus the amount of time required for incubations. Thick-walled
tubes delay sample heating, since heat transfers more slowly through the
tubes’ walls. For the earliest types of thermal cyclers this delay mattered
little. These machines’ ramping rates were so slow (below 1°C/sec) that
there was plenty of time for heat to transfer through the tube wall to the
sample, during a given incubation.

Modern thermal cyclers have much faster ramping rates (up to 2–3°C/
second), so the faster heat transfer provided by thin-walled tubes allows
protocols to be significantly shortened. For example, in the reaction illus-
trated in figure 4-x, over 30 seconds can be saved per cycle by using thin-
walled tubes, for an overall savings of 15 minutes in a 30-cycle run.

Sealing Sample Vessels
Steps must be taken to prevent the evaporation of water from reaction
mixtures during thermal cycling, to avoid changing the concentration of
reactants. Only a layer of oil or wax will completely prevent evaporation
from sample vessels. However, an adequate degree of protection can be
achieved by sealing with Microseal film or caps, then cycling the samples
using the heated lid to prevent condensation/refluxing.

Sealing with Oil or Wax
Mineral oil, silicone oil, paraffin wax, or Chill-out liquid wax may be
used to seal sample vessels. Use only a small amount of oil or wax; 1–3
drops (15–50µl) are usually sufficient. (Include this volume in the total
volume when setting up a calculated-control protocol; see “Setting Up a
Calculated-Control Protocol,” chapter 5.) Use the same amount of oil or
wax in all sample vessels to ensure a uniform thermal profile.

Most paraffin waxes solidify at room temperature. The wax can then be
pierced with a micropipette and the samples drawn off from below the
wax. Silicone oil and mineral oil can be poured off or aspirated from tubes
if the samples are first frozen (–15˚ to –20˚C). The samples are usually
pure enough for analysis without an extraction.

Chill-out liquid wax (available from MJ RESEARCH) is an easy-to-use alter-
native to oil. This purified paraffinic oil solidifies at 14˚C and is liquid at
room temperature. By programming a hold at low temperature, the wax
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can be solidified at the end of a run. A pipette can then be used to pierce
the wax in the tubes and remove the samples. The wax is dyed red to
assist in monitoring its use. The dye has no adverse effects on fluorescent
gel analysis of reaction products.

Sealing with the Hot Bonnet and Caps or Film Sheets
The Hot Bonnet’s heated inner lid maintains the air in the upper part of
sample vessels at a higher temperature than the reaction mixture. This
prevents condensation of evaporated water vapor onto the vessel walls,
so that solution concentrations are unchanged by thermal cycling. The
Hot Bonnet also exerts pressure on the tops of vessels loaded into the
block, helping to maintain a vapor-tight seal and to firmly seat tubes or
the plate in the block.

Caps, film, or mats must be used along with the Hot Bonnet to prevent
evaporative losses. Tight-fitting caps do the best job of preventing vapor
loss (and should be used for long-term storage of reaction products).

Microseal ‘A’ film is a quick way to seal Multiplate and “Concord”
microplates or large arrays of tubes. This film is specially designed to
seal tightly during cycling yet release smoothly, which minimizes the risk
of aerosol formation and cross-contamination of samples. Microseal ‘A’
is easily cut for use with fewer than 96 wells.

 Microseal ‘M’ rubber sealing mats are an economical means to seal 96-
well microplates. An array of 96 dimples on the mat helps orient it on the
microplate and prevents the mat from sticking to the Hot Bonnet’s heated
lid. The mats may be cleaned with sodium hypochlorite for reuse and are
autoclavable.

Note:Note:Note:Note:Note: After a hold at below-ambient temperatures, a ring of condensa-
tion may form in tubes above the liquid level but below the top of the
sample block. This is not a cause for concern since it occurs only at the
final cool-down step, when thermal cycling is finished.

Adjusting the Hot Bonnet’s Lid Pressure

The pressure exerted by the inner lid of the Hot Bonnet must be manually
adjusted to fit the sample vessels being used in a given reaction. Once set,
the Hot Bonnet can be opened and closed repeatedly without readjustment
as long as neither the tube or microplate type nor the sealing method
changes. Any change in vessel type or sealing method requires readjust-
ment of the Hot Bonnet’s lid.

Follow these steps to adjust the pressure exerted by the Hot Bonnet’s
inner lid:

1. Make sure the block’s wells are clean. Even tiny amounts of extraneous



4-94-94-94-94-9

Operation

material can interfere with the proper seating of a microplate or tubes,
which would prevent the inner lid from exerting uniform pressure
on the loaded microplate or tubes.

2. Open the Hot Bonnet. Turn the blue thumbwheel all the way counter-
clockwise to completely raise the inner lid.

3. Load either a microplate or at least eight individual tubes into the
sample block. The inner lid pivots around a central point, so it is im-
portant to distribute individual tubes evenly: Load at least four tubes
in the center of the block and at least one tube in each of the four
corners of the block. If using a sealing film or mat, apply it to the
loaded microplate according to the manufacturer’s directions.

4. Close the Hot Bonnet by pressing down on the top lever. Turn the
thumbwheel clockwise to lower the Hot Bonnet’s inner lid onto the
loaded microplate/tubes. The thumbwheel turns easily at first since
the inner lid has not yet come into contact with anything. Stop turn-
ing the thumbwheel when you feel increased resistance, which indi-
cates that the inner lid has touched the microplate/tubes.

5. Open the Hot Bonnet. Turn the thumbwheel clockwise an extra half
to three-quarters of a turn to set an appropriate lid pressure.

Caution:Caution:Caution:Caution:Caution: Do not turn the thumbwheel more than three-quarters of a
turn. This can make it hard or impossible to close the lid
and puts excessive strain on the latch holding the lid closed.

An extra half to three-quarters of a turn ensures the correct pressure for
most types of reaction vessels. Some empirical testing may be required
to determine the optimum pressure required for certain vessels. Once
this pressure has been determined, the thumbwheel position that deliv-
ers it may be marked with a colored marking pen or piece of tape.

Note:Note:Note:Note:Note: As an aid in gauging how much the thumbwheel has been
turned, mark it at the quarter turn positions, or every sixth “bump”
on the thumbwheel (there are 24 total “bumps”).

6. Close the Hot Bonnet.

Loading Sample Vessels into the Block
When using a small number of tubes, they should all be placed in the
center of the block, to ensure uniform thermal cycling of all samples. Also
load at least one empty tube in each corner of the block, to ensure that the
Hot Bonnet exerts even pressure on the sample tubes (see “Adjusting the
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Hot Bonnet’s Lid Pressure,” p. 4-8).

To ensure uniform heating and cooling of samples, sample vessels must
be in complete contact with the block. Adequate contact is ensured by
always doing the following:

• Ensure that the block is clean before loading samples (see chapter 10
for cleaning instructions)

• Firmly press individual tubes or the microplate into the block wells.

Using Oil to Thermally Couple Sample Vessels to the
Block
With two exceptions (see below), MJ RESEARCH does not recommend
using oil to thermally couple sample vessels to the block, for the fol-
lowing reasons:

• Calculated-control protocols do not run accurately when oil is used.

• Oil traps dirt, which interferes with thermal contact between vessels
and the block.

Caution:Caution:Caution:Caution:Caution: If you use oil in the block, use only mineral oil. Never use
silicone oil. It can damage the Alpha unit.

One exception to this recommendation involves the use of volatile radioac-
tive 35S nucleotides. A small amount of oil in the block can help prevent
escape of these compounds. See chapter appendix 4-B for important infor-
mation regarding safe use of these compounds in polypropylene tubes and
polypropylene and polycarbonate microplates. A second exception involves
the use of thick-wall 0.5-ml tubes. Certain brands of these tubes fit poorly in
the block, in which case oil may somewhat improve thermal contact. When-

Figure 4-3       A, Probe. B, Location of probe jack.

Probe  plug
Probe tube
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Probe
jack

BBBBB
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ever possible, use high-quality thin-wall tubes intended for thermal cycling
(see chapter appendix 4-A for a tube and plate selection chart).

Using the Optional Probe
The probe consists of a precision thermistor mounted in a thin-walled
plastic tube. A thin wire, encased in a small plastic tube, runs from the
thermistor to the probe’s plug, which is inserted into a slot at the back of
the Alpha unit (fig. 4-3). A small amount of oil is added to the probe tube
to serve as the representative sample. The tube is loaded into the block,
where it can serve as the control reference for any programmed target
temperature between 0˚ and 100˚C.

When a probe-control protocol is run, the DNA Engine controls block
temperature to keep the probe vessel at the programmed temperature,
using feedback information from the thermistor. (See chapters 5 and 6
for information on programming protocols for probe control.)

Note:Note:Note:Note:Note: Because the thermal characteristics of a probe can never precisely
match those of a sample, calculated control is often a better choice than
probe control.

Customizing the Probe Vessel
For the most precise control of sample temperatures, install the probe’s
thermistor in the same type of tube that the samples will be placed in.
This is particularly important when the sample tubes have much thicker
walls than the probe’s tube.

Follow these steps to customize the probe vessel:

1. Cut the hinge to the probe tube’s lid, if there is one. Remove the lid
and the attached the amber-colored thermistor.

2. Remove the lid from the new probe tube. Add oil to the probe tube as
described below under “Adding the Oil.”

3. Gently place the thermistor in the new tube, and snap the lid closed.
Make sure that the lid from the original probe tube fits the new tube
tightly . The probe wire may touch the sides of the tube. The ther-
mistor should rest on the bottom of the tube.

Caution:Caution:Caution:Caution:Caution: The thermistor is extremely fragile. Handle it with great care.
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Adding the Oil
Viscous oils are the best choice for the probe tube’s representative
sample. They closely mimic the thermal characteristics of buffer solu-
tion, which changes temperature sluggishly due to the high specific
heat of water. MJ RESEARCH recommends using heavy mineral oil, for
the following reasons:

• The calculations required to determine the correct volume of oil are easy.

• It is widely available and inexpensive.

Add mineral oil to the probe tube in the following proportions: 1 x the
volume of the buffer in an individual tube, plus 1 x the volume of oil
overlay if one is used. It is important to use the correct amount of oil, so
that the representative sample changes temperature at the same rate as
the actual samples. To add the oil, open the sample tube and pipette in
the appropriate amount. The oil must completely cover the thermistor.

Light and heavy silicone oil may also be used but necessitate more com-
plex calculations to determine the amount to add to the probe tube. See
chapter appendix 4-C for information on using these oils.

Note:Note:Note:Note:Note: Use only mineral oil or silicone oil as the representative sample.

Figure 4-4   Correctly inserted probe.

Probe plug, seated
in jack

Probe wire, exiting
to left of plug
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Do not use paraffin wax or Chill-out liquid wax, or the probe readings
will not be accurate.

Caution:Caution:Caution:Caution:Caution: Do not use water, saline, or any other aqueous solution
as a representative sample. Aqueous solutions will de-
stroy the thermistor.

Loading and Connecting the Probe
Seat the probe tube in the center of the block (fig. 4-4, p. 4-12). If oil is
used to thermally couple samples to the block, it must also be used on
the probe tube (but see “Using Oil to Thermally Couple Sample Vessels
to the Block,” p. 4-9).

Plug the probe into the jack at the back of the block, so that the wire is to
the left of the plug (fig. 4-4).

Detecting a Faulty Probe
If the DNA Engine detects that the probe is broken or missing when a
protocol begins running, the protocol’s temperature control method is
automatically switched from probe control to calculated control, and the
following message is immediately displayed:

If the probe malfunctions during a protocol run, the temperature control
method is also switched to calculated control, and the run-time screen
changes to say “Calc” instead of “Probe.” When the run finishes, the fol-
lowing message is displayed:

Run: CUSTOM1

Probe Sensor Failure

  Used Calc Control

Run: CUSTOM1

CALC control:

Probe not present
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Key
� Reaction vessel fits block without modification.
❍ Reaction vessel must be cut to fit this block.

* Microseal ‘M’ and ‘P’ sealers are sized for 96-well blocks but can be used with fewer than 96
wells if the vessels are placed symmetrically in the block. Microseal ‘P’ pads are intended for
use with Power Bonnet motorized lids.

Note:Note:Note:Note:Note: All tubes and multiplate microplates are made from polypropylene plastic, the optimal
material for this application. “Concord” microplates are made from polycarbonate plastic, which
is more prone to poor sealing and vapor leakage.

Tube, Microplate, and Sealing
System Selection Chart
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Some researchers have experienced a problem with radioactive contamination when using 35S in
thermal cyclers. This problem has occurred with all types of reaction vessels.

The Problem
When 35S nucleotides are thermally cycled, a volatile chemical breakdown product forms, prob-
ably SO2. This product can escape the vessel and contaminate the sample block of a thermal cycler,
and possibly the air in the laboratory. Contamination has been reported with microassay plates,
0.2-ml tubes, and 0.5-ml tubes.

96-Well and 192-Well Polycarbonate Microplates

These microplates present the largest risk of contamination. Polycarbonate is somewhat perme-
able both to water and the 35S breakdown product. This problem is exacerbated when polycarbon-
ate plates are held at high temperatures for long periods of time, or when the plates are sealed for
oil-free thermal cycling.

0.2-ml Polypropylene Tubes and 96-Well Polypropylene Microplates

These tubes are manufactured with very thin walls to enhance thermal transfer. The thin walls
are somewhat fragile and can “craze” or develop small cracks when subject to mechanical
stress. Undamaged thin polypropylene tubes may also be somewhat permeable to the 35S break-
down product. Either way, there have been reports of 35S passing through the walls of 0.2-ml
tubes of several different brands during thermal cycling. No data are yet available on radio-
active contamination with polypropylene microplates.

0.5-ml Polypropylene Tubes

Contamination problems are rarer with this type of tube, but instances have been reported.

The Solution
1. Substitute the low-energy beta emitter 33P in cycle sequencing. 33P nucleotides are not subject

to the same kind of chemical breakdown as 35S nucleotides, and they have not been associated
with volatile breakdown products.

2. If 35S must be used, three things will help control contamination: an oil overlay inside the
tubes, mineral oil in the thermal cycler outside the tubes, and use of thick-walled 0.5-ml tubes.
Always run 35S thermal cycling reactions in a fume hood, and be aware that vessels may be
contaminated on the outside after thermal cycling. Please be certain that you are using the

Appendix 4-B Safety Warning Regarding Use
Of 35S Nucleotides
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appropriate detection methods and cleaning procedures for this isotope. Consult your radia-
tion safety officer for his or her recommendations.

If mild cleaning agents do not remove radioactivity, harsher cleaners may be used. Users have
suggested the detergent PCC-54 (Pierce Chemical Co., Rockford, Illinois; Pierce Eurochemie B.V.,
Holland), Micro Cleaning Solution (Cole-Parmer, Niles, Illinois), and Dow Bathroom Cleaner (avail-
able in supermarkets).

Caution:Caution:Caution:Caution:Caution: Harsh cleaning agents are corrosive to aluminum and must never be used on bare
aluminum blocks. MJ RESEARCH blocks are anodized, so they have a protective coating
of aluminum oxide. Still, harsh agents (such as those above) must be thoroughly rinsed
away within a few minutes of application, or the anodization will degrade.

Operation
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Using Silicone Oil in the Probe TubeAppendix 4-C

The following light and heavy silicone oils may be used instead of mineral oil as the representa-
tive sample in a probe tube:

• Dow Corning #200 light silicone oil (dimethypolysiloxane, Sigma #DMPS-5X)

Density: 0.97g/ml

Viscosity: 50cs

Volume to use: 1.7 x volume of buffer in individual sample tube, plus one volume of oil overlay.

• Dow Corning #200 heavy silicone oil (dimethypolysiloxane, Sigma #DMPS-V)

Density: 0.97g/ml

Viscosity: 5cs

Volume to use: 2.7 x volume of buffer in individual sample tube, plus one volume of oil overlay.

Note:Note:Note:Note:Note: Use these oils only in the proportions outlined above. Using them in any other proportion
(for example, 1:1 with sample tube volumes) will lead to inaccurate sample heating.
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Running a Protocol
Running a protocol on the DNA Engine involves three steps:

1. Choosing a stored protocol to run

2. Choosing a block to run it on, if a dual-block Alpha unit is installed

3. Setting up the temperature control method

Either a custom-designed protocol or one of the factory-installed resi-
dent protocols may be run. See appendix F for descriptions of the resi-
dent protocols, which may be edited to fit your needs (see chapter 7). All
the factory-installed protocols are stored in a single folder, called the
<MAIN> folder, at the time of shipping.

Choosing a Stored Protocol to Run
With the Main Menu displayed, select Run, then press «Proceed». One
of two types of screen will be displayed, depending on whether custom
protocols have been stored in the <MAIN> folder or in custom folders:

• If all protocols have been stored in the <MAIN> folder:

The first of three or more screens listing the protocols will be displayed.
Custom protocols are listed first, then the 14 factory-installed programs:

Use the «Select» keys to scroll through the listed protocols. Scroll
past the last- or first-listed protocol to see the next screen down or up.
Select the desired protocol, then press «Proceed».

• If custom protocols have been stored in one or more custom folders:

One or more screens listing all the folders residing in the machine will
be displayed:

Select the folder that contains the protocol, then press «Proceed». One
or more screens listing the protocols stored in the folder will be dis-
played. Use the «Select» keys to scroll through the listed protocols.
Select the desired protocol, then press «Proceed».

Run:

_<MAIN>    <FOLDER1>

 <FOLDER2> <FOLDER3>

Run:      <MAIN>

_CUSTOM1   CUSTOM2

 QUIKSTEP  2-STEP

 3-STEP    EXTEND
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In either instance, after you press «Proceed», a screen similar to the fol-
lowing example will be displayed:

The top line of the screen will identify the selected protocol (2-STEP in
the example). The other lines on the screen will request information
needed to set up the temperature control method (explained below).

Choosing a Block to Run the Protocol On
If a dual-block Alpha unit is installed (or if networked Alpha units are
available; see chapter 9), one of the blocks must be designated to run the
protocol. The first available block is automatically designated when a
protocol is chosen. Press «Block» to choose a different block. The selected
block’s letter is identified in the upper right-hand corner of the screen:

The status indicator light for the selected block will flash green.

Setting Up the Temperature Control Method
When the protocol is selected (and the correct block is designated for a
dual-block Alpha unit), one or more screens will be displayed. These
screens will ask for information needed to set up the block’s temperature
control method. The DNA Engine can control the block’s temperature in
three different ways: block control, calculated control, and probe con-
trol. Chapter 6 explains in detail how these methods work and their im-
plications for protocol design. The following describes how to respond
to the screens that are displayed for each control method. When these
screens have been dealt with, the protocol will begin to run.

Setting Up a Block-Control Protocol

A single screen asking about use of the heated lid will be displayed:

Run: 2-STEP   on  A

Vessel Type:

   _TUBES   Plate

Run: 2-STEP

Vessel Type:

   _TUBES    Plate

Run: ICEBUKET

Use heated lid?

      Yes  _NO
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Select Yes or No, then press «Proceed». The protocol will begin running.

Setting Up a Calculated-Control Protocol

Three screens will be presented:

• A screen asking for sample vessel information:

Select from the options shown (may include tubes, plates, and slides),
then press «Proceed». Choose Plate for polycarbonate microplates and
Tube for polypropylene tubes or polypropylene microplates. For blocks
that hold only tubes, choose Thin or Thick, depending on the type of
tube loaded.

Note:Note:Note:Note:Note: See “Using Calculated Control” in the Twin Tower Block Opera-
tions Manual for information on specifying slide format.

• A screen asking for the sample reaction volume (last line in example
below):

Use the keypad to enter a sample volume in microliters, then press
«Proceed». If sample vessels are sealed with oil or wax, include the
volume of the oil or wax in the total sample volume entered.

Note:Note:Note:Note:Note: Specify 10µl for any volume less than 10µl.

NoteNoteNoteNoteNote: Verify that your vessel sealing system is adequately tight be-
fore performing 5-µl reactions.

• A screen asking about use of the heated lid. Select Yes or No, then
press «Proceed». The protocol will begin running.

Run: 2-STEP

Vessel Type:

   _TUBES   Plate

Run: 2-STEP

Vessel Type: TUBES

Volume (µl):   10
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Setting Up a Probe-Control Protocol

A single screen asking about use of the heated lid will be displayed. Se-
lect Yes or No, then press «Proceed». If the probe is installed, the probe
verification screen will be displayed:

Ensure that the probe is correctly installed (see “Loading and Connecting the
Probe,” chapter 4), then press «Proceed». The protocol will begin running.

If the probe is not installed, a warning message will be displayed:

This screen says that since the probe is missing, the DNA Engine will
run the protocol using calculated control if «Proceed» is pressed now. To
avoid this, press «Cancel», install the probe, and set the protocol up again.
When the probe verification screen is displayed, press «Proceed» to be-
gin the protocol run.

Reading the Runtime Screen
During a protocol run a runtime screen will be displayed:

The screen lists the protocol name (2-STEP in the example above), proto-
col step that is running (1 ), cycle number (1), method of temperature
control (Calc), and the block temperature for block-control protocols, the
calculated sample temperature for calculated-control protocols (68.0), and
the probe temperature for probe-control protocols. When the step’s tar-
get temperature is reached, a timer begins running in the lower right-

Run: PROBE1

PROBE control:

Verify probe ready

RUN: PROBE1

CALC control:

  Probe not present

Run: 2-STEP

 1=  92.0˚ for 0:05

Cycle:  1

Calc:  68.0˚
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hand corner of the screen. The first digit is the minutes elapsed; the two
digits after the colon are the seconds elapsed.

For protocols using calculated control or probe control, press the left «Se-
lect» key to display the block’s temperature on the third line of the screen:

This screen shows only as long as the left «Select» key is pressed. The
runtime screen returns when you stop pressing the key.

Press the right «Select» key to see a screen listing the cycle number (if a
GoTo step is executing), time elapsed so far for the protocol run, and
estimated remaining time left in the run:

This screen is also displayed only as long as the key is pressed. The runtime
screen returns when you stop pressing the key.

Switching Between the Runtime Screen and the Main
Menu
Press «Block» to toggle between the runtime display and the Main Menu.
This allows you to edit a stored program, enter a new one, print a pro-
gram, run another protocol on a dual-block Alpha unit or networked DNA
Engine, or use the file utilities, while the protocol runs.

Reading the Protocol Completion Screen
When the protocol run finishes, a long beep sounds, and a notification
screen is displayed:

Certain error messages may also be displayed in this screen (see chap-
ter 11). Press «Proceed» to return to the Main Menu.

Run: 2-STEP

  PROGRAM COMPLETE

Total time:    50:31

Run: 2-STEP

Cycle:   1

Total time:     0:20

Est remain: 1:01:51

Run: 2-STEP

 1=  92.0˚ for 0:05

Block: 62.1

Calc:  68.0˚



5-75-75-75-75-7

Running Protocols

Printing a Log for a Running Protocol
If the DNA Engine is connected to a printer, you can print a log for the
run that includes

• The DNA Engine’s serial number and software version

• The protocol’s name

• The temperature control method for the protocol

• A list of the protocol’s steps

• The runtime thermal data

To print a runtime protocol log, first ensure that a printer is connected to
the machine. See “Printing a Program,” chapter 8, for information about
compatible printers.

Follow the instructions under “Choosing a Printer Port,” chapter 8, to
prepare the DNA Engine to communicate with your printer.

As long as a printer is connected to the machine, the following screen
will appear whenever a protocol is run:

To print the protocol as it runs, select Yes, then press «Proceed».

Note:Note:Note:Note:Note: If no printer is connected to the machine, the screen allowing you
to select printer output is not displayed at all.

Run: 2-STEP

Printer output?

_YES   No
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Manually Stepping Through a Protocol
Once a protocol is running, pressing «Proceed» gives you the option
of immediately advancing the protocol to the next programmed step,
even if the machine is currently ramping the block’s temperature (see
chapter 6 for information on ramping). A confirmation screen will be
displayed:

Select Yes, then press «Proceed». The protocol will advance to its next step.

Pausing a Running Protocol
Press «Pause» to temporarily stop a running program. The timer in the lower
right-hand corner of the runtime screen will be replaced by the word “Pause”:

The samples are held at the displayed temperature until either the «Pause»
or the «Proceed» key is pressed, which causes the protocol run to re-
sume.

A protocol cannot be paused before the target temperature for a given
step has been reached. If «Pause» is pressed before this point, the block
continues heating or cooling until the target is reached, and then the pro-
tocol is paused.

Stopping a Running Protocol
Press either «Stop» or «Cancel» to stop a running protocol. A cancella-
tion confirmation screen will be displayed:

Run: 2-STEP

Stop 2-STEP?

      Yes  _NO

Run: 2-STEP

 1=  92˚ for 0:05

Cycle:  1

Calc:  92˚     PAUSE

Run: 2-STEP

Go on to next step?

     _YES   No
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Select Yes, then press «Proceed» to cancel the protocol. The total run time
for the protocol will be displayed:

Press «Proceed» to return to the Main Menu.

Note:Note:Note:Note:Note: Turning off the machine does not stop a running protocol. The
DNA Engine will assume the protocol was stopped by a power outage
and will resume running the protocol when the machine is turned back
on (see below).

Resuming a Protocol after a Power Outage
If a power failure occurs when a protocol is running, the DNA Engine
will hold the protocol in memory for a minimum of 24 hours to a maxi-
mum of 7 days, depending on environmental conditions.

When power is restored, the protocol will begin running again at the
point at which it was stopped, and a notice about the power interruption
will be displayed. The notice will identify the step and the cycle that were
running when the power failure occurred, and the block’s temperature
at the time power was restored:

Press «Proceed» to remove this screen. The protocol’s runtime screen
will immediately be displayed.

Run: 2-STEP

   PROGRAM CANCELED

Total time:     1:15

Run: 2-STEP

  A/C POWER FAILED

 Cycle 1    Step 1

Recovered at 20.2˚
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Using the Instant Incubation Feature
The DNA Engine may be converted to a constant-temperature incubator
by pressing «Instant Incubate». A screen allowing use of the heated lid
will be displayed:

Use the «Select» keys to enable or disable the heated lid, then press «Pro-
ceed».  A screen allowing entry of the incubation temperature will be
displayed.

Use the keypad to enter any incubation temperature from –5.0˚C to
105.0˚C, then press «Proceed». The DNA Engine will incubate the sample
at the specified temperature until «Cancel» or «Stop» is pressed.

When the sample block reaches the incubation temperature, a timer be-
gins running in the lower right-hand corner of the screen. To stop and
start the timer, press «Pause».

Tip:Tip:Tip:Tip:Tip: The Pause feature is useful if you need to temporarily remove
samples that must be incubated for a precise period of time.
Pausing the timer while samples are not in the block allows
you to track the exact duration of their incubation.

INCUBATE:

 Use heated lid?

     Yes  _No

✔

INCUBATE:

 1=  20.0°  for ever
 Use heated lid?

     Yes  _No
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The Elements of a Program
DNA Engine programs consist of a series of steps encoding a protocol.
These steps are run using one of three possible temperature control meth-
ods: calculated control, block control, and probe control.

Programs may contain five types of steps. Two of the steps are manda-
tory, and two are optional:

1. Temperature step (mandatory): Sets a temperature for the block and
the length of time it is held at that temperature. The DNA Engine
brings the block to this temperature at its maximum rate of heating
or cooling, unless modifying instructions are added to the program.
(The maximum rate of heating and cooling is up to 3˚C/sec for all
single- and dual-block Alpha units; 1.2˚C/sec for the Twin Tower.)

2. Gradient step (optional): allows you to program a temperature gra-
dient across the sample block.  The range of any single gradient can
be as great as 24°C from left to right.  The maximum programmable
temperature is 105°C; the minimum programmable temperature is
30°C.

3. Ramp step (optional): Sets a slower-than-maximum rate of heating
or cooling.

4. GoTo step (optional): Causes the program to cycle back to an earlier
step for a specified number of times (up to 9,999 times).

5. End step (mandatory): Instructs the DNA Engine to shut down its
heat pump because the program is complete.

Additional instructions, termed “options,” can be added to certain pro-
gram steps to modify their effects:

1. Increment: Modifies a temperature step to allow a progressive increase
or decrease of temperature (0.1˚–10.0˚C per cycle) each time the step is
executed in a cycle. This is useful in “touchdown” programs, when the
annealing temperature of an oligonucleotide is not known.

2. Extend: Modifies a temperature step to allow progressive lengthen-
ing or shortening of a temperature step hold (by 1–60 sec/cycle) each
time a step is executed in a cycle. This is useful for accommodating
an enzyme with diminishing activity.

3. Beep: Modifies a temperature step or ramp step to make the machine
beep when the target temperature is reached.
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Designing a New Program

Translating a Protocol into a Program
Until you are completely familiar with programming the DNA Engine,
you may find it helpful to first translate the protocol into DNA Engine
program steps and options on paper. Write down the  protocol to be pro-
grammed, one step per line. Then write the type of program step that
goes with the protocol steps, at the end of each line.  If a protocol step
involves an option as well as a program step, write both names down on
the same line. Finally, write the End step at the bottom of the list; pro-
grams will not run without this step. Number the lines 1 through N, where
N is the final, End line.

Using the GoTo Step to Write Short Programs
The GoTo step allows programs of many repetitious steps to be short-
ened to just a few lines. When the program encounters a GoTo step, it
returns to a specified step, repeats that step, and repeats all steps that
follow, back to the GoTo step. When the program has returned, or cycled,
back to the step a specified number of times, the program moves on to
the step that follows the GoTo step.

For example, consider a basic cycle sequencing protocol consisting of 30
repeats of a denaturation, and an annealing/extension step. Rather than
listing all 60 steps, use a GoTo step to design a short, easy-to-enter pro-
gram:

Raw program:Raw program:Raw program:Raw program:Raw program:

1. 92˚ for 30 sec
2. 60˚ for 3 min
3. 92˚ for 30 sec
4. 60˚ for 3 min
5. 92˚ for 30 sec
6. 60˚ for 3 min
7. 92˚ for 30 sec

[continues for total of 60 lines]

Choosing a Temperature Control Method
The DNA Engine can control block temperature in three possible ways,
each of which has different implications for the speed and accuracy of
sample heating:

• Calculated control: The DNA Engine adjusts the block’s tempera-
ture to maintain samples of a specific volume in a specific vessel type

DNA Engine program:DNA Engine program:DNA Engine program:DNA Engine program:DNA Engine program:

1. 92˚ for 30 sec
2. 60˚ for 3 min
3. GoTo step 1, 29 times (i.e.,

cycle back to step 1 and repeat
steps 1and 2, 29 times )

5. End
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at programmed temperatures. This includes optimized “overshoots”
of the block by a few degrees for a few seconds, which bring the
samples to the programmed temperatures.

• Block control: The DNA Engine adjusts the block’s temperature to
maintain the block at programmed temperatures, independent of
sample temperature.

• Probe control: The DNA Engine adjusts the  block’s temperature to
maintain the probe at programmed temperatures.

Calculated Control

Calculated control is the method of choice for most types of programs,
yielding the  most consistent, most reliable, and fastest programs. When
using calculated control, the DNA Engine maintains a running estimate
of sample temperatures based on the  block’s thermal profile, the rate of
heat transfer through the sample tube or slide, and the sample volume or
mass (this information about the samples is provided when a program is
run; see “Setting Up the Temperature Control Method,” chapter 5). Since
this estimate is based on known quantities and the laws of thermody-
namics, sample temperatures are controlled much more accurately than
with block or probe control.

Hold times can be shortened significantly when protocols are run under
calculated control. In addition to the simple convenience of spending less
time running reactions, shorter protocols also help preserve enzyme activ-
ity and minimize false priming. Cycling denaturations run under calculated
control are usually optimal at 5 seconds.  Annealing/extension steps can
also be shortened, but the periods for these will be reaction specific.

Calculated control provides for shorter protocols in three ways:

1. Brief and precise block temperature overshoots are used to bring
samples to temperature rapidly.

2. Incubation periods are timed according to how long the samples, not
the block, reside at the target temperature.

3. The machine automatically compensates for vessel type and reaction
volume.

Block Control

Block control provides less accurate control of sample temperatures than
calculated control provides. Under block control, the temperature of
samples always lags behind the temperature of the block. The length of
the time lag depends on the vessel type and sample volume but typically
is between 10 and 30 seconds. Block control is chiefly used to run proto-
cols developed for other thermal cyclers that use block control.
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Probe Control

Probe control is available for unusual circumstances that may require it.
Ordinarily, though, it should be used with caution. While the DNA En-
gine will have no trouble heating the probe to the target temperature, if
the probe is seated or prepared differently from the sample tubes, actual
sample temperatures can vary widely from the probe’s temperature. Probe
control also cannot be used with microplates or slides.

Modifying Block- and Probe -Control Programs for Calculated Control

Probe-control programs will generally run well under calculated control,
with no modification other than changing the method of temperature
control. Block-control programs can be changed to calculated control by
subtracting at least 15–20 seconds from each temperature step. Some
empirical testing may be required to adjust modified programs for opti-
mum performance.

Modifying a Program Designed for a Different Machine
The ramp programming step can be used to adapt programs designed
for thermal cyclers with slower maximum heating and cooling rates than
the DNA Engine. In addition, a given protocol will occasionally work
better with a slower rate of temperature change; the ramp step can be
used to optimize the program for such a protocol.

Entering a New Program
Programming the DNA Engine moves through five steps:

1. Initiating the program

2. Naming the program

3. Choosing a temperature control method

4. Entering the program’s steps

5. Entering the End step

Each step involves entering values from the keyboard or making
selections from a menu. Programs may be edited as they are being
entered.

Programs are automatically saved when the End step is entered. They
are stored in the <MAIN> folder unless folders have been created for
them.
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Initiating the Program
To initiate a new program, select Enter from the Main Menu, then press
«Proceed». A naming screen will be displayed:

Naming the Program
Name the program an eight-character word consisting of any combina-
tion of letters (Roman and Greek), numbers, punctuation marks, or Japa-
nese Katakana.

Press the right «Select» key to scroll forward and the left «Select» key to
scroll backward through the alphabets and characters available, which are
presented in this order: Roman alphabet, selected Greek letters, punctua-
tion marks, numbers. To access the Japanese Katakana syllabary, press the «.»
key. A second press of «.» returns the machine to Western characters.

When the character needed is displayed next to Name, press «Proceed».
The character will be accepted, and the cursor will move one space to the
right. Numbers and dashes may also be inserted by pressing the corre-
sponding keys on the keypad.

When the name is complete, press «Proceed» once to accept the last char-
acter and again to accept the whole name. If the name is already in use
for a program, a screen saying “Name In Use” will be displayed. If this
happens, press «Proceed», then enter a different  name.

Choosing a Temperature Control Method
When the name has been entered (“CUSTOM1” is used in the following
and all succeeding examples), a screen requesting selection of a tempera-
ture control method will be displayed:

Select a control method, then press «Proceed».

Entering the Program’s Steps
When a temperature control method has been chosen, the Enter Menu
will be displayed:

Enter: CUSTOM1

Control method:

    Block    Probe

   _CALCULATED

Enter:

Name: A
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Use this menu to enter each step of the program:

• Temp enters a temperature step.

• Gradient enters a Gradient step.

• GoTo enters a GoTo step (note: since a protocol can not begin with a
GoTo step,GoTo does not appear on the initial Enter Menu).

• Ramp enters a ramp step.

• End enters the End step.

Entering a Temperature Step

To enter a temperature step, select Temp from the Enter Menu, then press
«Proceed». The first Temp screen will be displayed:

The second line of this screen shows the number of the step being
programmed (1 is used in the example above). The last line of the
screen allows a target temperature (in degrees Celsius) to be entered
for the step.

Use the keyboard to enter any number between –5.0 and 105.0 as the
target temperature (92.0 is used in the example below):

Press «Proceed». The target temperature will move to the second line of
the screen, and a line allowing a hold time to be entered for the step will
be displayed:

Enter the hold time for the step (30 seconds is used in the example be-

Enter: CUSTOM1

Step 1= _TEMP

         Gradient

         Ramp  End

Enter: CUSTOM1

 1=

Temp ˚C:   _

Enter: CUSTOM1

 1=

Temp ˚C:  92.0

Enter: CUSTOM1

 1= 92.0˚

Time:        _



6-86-86-86-86-8

DNA Engine & DNA Engine Tetrad Operations Manual

low):

Note:Note:Note:Note:Note: If a hold time of zero (0) is entered, the DNA Engine will hold the
block at the target temperature indefinitely.

Press «Proceed». The hold time will move to the second line of the screen,
and a confirmation menu will be displayed on the last line:

Select one of the displayed choices, then press «Proceed»:

• Yes  accepts the step and displays the Enter Menu again. Use the En-
ter Menu to enter the next step in the program.

• No allows reentry of the target temperature and hold time for the
step.

• Option displays the Options Menu (see “Modifying a Program Step
with the Options,” p. 6-11).

Tip:Tip:Tip:Tip:Tip: Avoid programming many short holds of only a few seconds
each. This can overheat the block, causing the “HS Overheat-
ing” or “PS Overheating” error messages to be displayed and
triggering automatic Alpha unit shutdowns if the block exceeds
its maximum allowable temperature.

Entering a Gradient Step

When you reach the step at which a gradient is desired, select Gradient
from the Enter Menu and then press the «Proceed» key.  For the purpose
of this example the step in which the gradient will be entered shall be
Step 2:

Enter: CUSTOM1

Step 2= Temp  Goto

_GRADIENT

Ramp  End

Enter: CUSTOM1

 1=  92.0˚ for  0:30

OK? _YES  No  Option

✔

Enter: CUSTOM1

 1= 92.0˚

Time:       30
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The gradient screen will appear:

Enter: CUSTOM1

Lower Temp ° C:

Enter the lower limit temperature (for the purposes of this example, 50°),
then press «Proceed».  The upper temperature screen will appear:

Enter: CUSTOM1
        50.0°

Upper Temp ° C:

Enter the upper temperature (for the purposes of this example, 70°), then
press «Proceed».  (Use integers only; decimals are not accepted).

The next screen requires you to enter a hold time for the temperature
gradient step:

Enter: CUSTOM1
2= 50.0°  to 70.0°

Time:

Enter the hold time in the form of min:sec.  Press «Proceed».  A confirma-
tion screen will appear:

Enter: CUSTOM1

2= 50.0°  to 70.0°
for 0:30

OK? Yes No Option

Select “Yes” to enter the step into memory and proceed to the next step;
select “No” to reject or edit the current step.  To preview, select Option,
then Preview.  Preview gives the predicted temperatures for each of the
wells along the sample block’s long axis.  (The lines do not all appear in
the display; use the «Select» keys to scroll up or down.)

Gradient Preview:

Column 1— 50.0°  left
Column 2— 51.8°
Column 3— 53.6°
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Editing a gradient step

To edit a gradient step, select Edit from the Main Menu.  The program
will be displayed as follows:

List: CUSTOM1

1= 92.0°  for 0:20
2= 50.0°  to 70.0°

for 0:30

Use the «Select» keys to scroll to the step you want to edit.

Reviewing a gradient program

After the protocol has been run, the Program Complete screen will be dis-
played.  Press the «Proceed» key, and the next screen will display  a re-
view of the gradient well temperatures:

Gradient Review:

Column 1-  50.0°  left
Column 2-  50.5°
Column 3-  51.5°
Column 4-  53.2°
Column 5-  55.5°
Column 6-  58.4°
Column 7-  61.8°
Column 8-  64.6°
Column 9-  66.8°
Column 10- 68.4°
Column 11- 69.6°
Column 12- 70.0° right

Scroll up and down the screen using the «Select» keys.  When scrolling
the “Gradient Review” line will be held constant while the lower 3 lines
can be manipulated up or down.  The temperatures  displayed will be for
each of the twelve wells along the long-axis of the sample block.  These
temperatures will be predicted from an algorithm as a steady-state tem-
perature of the block and the sample.  You may then return to the main
menu by pressing the «Proceed» key.

Using the gradient calculator

The gradient calculator predicts, for a given gradient, the temperatures
for each of the twelve wells along the long-axis of the sample block.  These
temperatures will be predicted from an algorithm as a steady-state tem-
perature of the block and the sample.  To use the gradient calculator,
select the List command from the main menu and then press the  «Pro-
ceed» key.  You will see a List  screen:
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List:
  Programs
  _GRADIENT CALCULATOR

Select Gradient Calculator  and press the «Proceed» key :

Lower Temp ° C:  50.0°
Upper Temp ° C:  70.0°

Enter  lower limit temperature of the gradient using the number keys
and then press the «Proceed» key. Enter the upper temperature for the
gradient using the number keys and «Proceed» key.  You may enter inte-
gers without decimal points.  The following screen will be displayed:
Gradient Calculator:

Column 1-  50.0°  left
Column 2-  50.5°
Column 3-  51.5°
Column 4-  53.2°
Column 5-  55.5°
Column 6-  58.4°
Column 7-  61.8°
Column 8-  64.6°
Column 9-  66.8°
Column 10- 68.4°
Column 11- 69.6°
Column 12- 70.0° right

You may scroll up and down the screen using the «Select» keys.  When
scrolling, the “Gradient Calculator” line will be held constant while the
lower 3 lines can be manipulated up or down.
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Entering a Ramp Step

To enter a ramp step, select Ramp from the Enter Menu. The first Ramp
screen will be displayed:

The second line of this screen shows the number of the step being pro-
grammed (3 is used in the example above). The last line of the screen
allows a ramp rate (in degrees Celsius per second) to be entered for the
step.

Use the keyboard to enter any rate up to 2.5˚C/sec (1˚C/sec is used in the
example below):

NoteNoteNoteNoteNote:   If a ramp rate faster than the Alpha unit’s maximum rate of heat-
ing and cooling is entered, the maximum rate will be used.

Press «Proceed». The ramp rate will move to the second line of the screen,
and a line allowing entry of a finish temperature for the ramp step will
be displayed:

Enter the finish temperature for the ramp step (69˚C is used in the ex-
ample below):

Press «Proceed». The finish temperature will be moved to the second line of
the screen, and a confirmation menu will be displayed on the last line:

Enter: CUSTOM1

 3=

Rate ˚C / s: _

Enter: CUSTOM1

 3=

Rate ˚C / s: 1

Enter: CUSTOM1

 3= 2.0˚/s

Finish temp:    _

Enter: CUSTOM1

 3= 2.0˚/s

Finish temp:  69
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Select one of the displayed choices, then press «Proceed»:

• Yes  accepts the step and displays the Enter Menu again. Use the En-
ter Menu to enter the next step in the program.

• No allows reentry of the ramp rate and finish temperature.

• Option  displays the Options Menu (see “Modifying a Program Step
with the Options,” p. 6-11).

Tip:Tip:Tip:Tip:Tip: A ramp step will not hold the block at its finish tempera-
ture. Instead, as soon as finish temperature is reached, the
next step of the program will immediately be executed. To
hold the block for some period of time at a ramp step’s fin-
ish temperature, make sure a temperature step immediately
follows the ramp step, and program the hold at the finish
temperature into this step.

Entering a GoTo Step

To enter a GoTo step, select GoTo from the Enter Menu. The first GoTo
screen will be displayed:

The second line of this screen shows the number of the step being pro-
grammed (5 is used in the example above). The last line of the screen
allows entry of the number of the step the program should cycle back to.

Enter the number of the step the program should cycle back to (1 is used
in the example below):

Enter: CUSTOM1

 3= 2.0˚/s to  69.0˚

OK? _YES  No  Option

Enter: CUSTOM1

 5=GoTo

GoTo step: _

✔

Enter: CUSTOM1

 5=GoTo

GoTo step: 1
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Press «Proceed». The step number will move to the second line of the
screen, and a line allowing an additional number of cycles to be entered
will be displayed:

Enter the additional number of times the program should cycle back to
the step (3 is used in the example below):

Press «Proceed». The number of additional cycles will move to the sec-
ond line of the screen, and a confirmation menu will be displayed on the
last line:

Select one of the displayed choices, then press «Proceed»:

• Yes accepts the step and displays the Enter Menu again. Use the En-
ter Menu to enter the next step in the program.

• No allows reentry of the step number and number of additional cycles.

Entering the End Step

To enter the End step, select End from the Enter Menu. The single End
screen will be displayed:

This screen automatically enters “End” on on the second line of the screen,
next to a step number, and displays a confirmation menu for the step on
the last line of the screen.

Enter: CUSTOM1

 3=GoTo 1

Addtnl cycles:    _

Enter: CUSTOM1

 3= GoTo 1,  3 times

OK? _YES  No

Enter: CUSTOM1

 3=GoTo 1

Addtnl cycles:    3

Enter: CUSTOM1

 4=End

OK? _YES  No
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Select one of the displayed choices, then press «Proceed»:

• Yes  accepts the step, stores the program, and displays the Main Menu.

• No displays the Enter Menu so that additional steps can be added.

If you have created custom folders for your programs (see chapter 8),
choosing Yes brings up a screen listing the folders:

Select the folder you want to store the program in, then press «Proceed». The
program will be stored in the folder, and the Main Menu will be displayed.

Modifying a Program Step with the Options
The Options Menu is accessible from the confirmation menus of tempera-
ture steps and ramp steps. To access the Options Menu, select Option from
the confirmation menu of a temperature or ramp step, then press «Proceed».
The Options Menu will be displayed on the bottom line of the screen:

• Inc modifies a temperature step with an increment option. An incre-
ment option allows a progressive increase or decrease of temperature
each time the step is executed in a GoTo cycle.

• Ext modifies a temperature step with an extend option. An extend op-
tion allows a progressive lengthening or shortening of hold times each
time the step is executed in a GoTo cycle.

• Beep modifies a temperature step or a ramp step, causing the ma-
chine to beep when a specified target temperature is reached.

Entering an Increment Option
To enter an increment option, select Inc from the Options Menu for a
temperature step, then press «Proceed». The first Inc screen will be dis-

Save program in:

<MAIN>  <FOLDER1>

<FOLDER2>

Enter: CUSTOM1

 1=  92.0˚ for  0:30

Option:_INC Ext Beep
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played:

The temperature step being modified appears on the second line of this
screen. The plus sign on the third line means that the screen is set up to
enter a progressive increase in temperature per cycle. Press «–» to switch
to a minus sign, allowing entry of a progressive decrease in temperature.
Press «Cancel» to change back to a plus sign.

Enter the numerical value of the temperature increase or decrease (1.2 is
used in the example below):

Press «Proceed». The Inc value just entered will move to the third line of the
screen, and a confirmation menu will be displayed on the last line:

 Select one of the displayed choices, then press «Proceed»:

• Yes accepts the Inc value and displays the Enter Menu again. Use the
Enter Menu to enter the next step in the program.

• No allows reentry of the Inc value.

• Option displays the Options Menu again. Use the Options Menu to
enter another option for the step.

Entering an Extend Option
To enter an extend option, select Ext from the Options Menu of a tem-
perature step, then press «Proceed». The first Ext screen will be dis-
played:

Enter: CUSTOM1

 1=  92.0˚ for  0:30

    +

Sec / cycle:  +  _

Enter: CUSTOM1

 1=  92.0˚ for  0:30

    +

˚C / cycle:  + _

Enter: CUSTOM1

 1=  92.0˚ for  0:30

    + 1.2˚ per cycle

OK? _YES  No  Option

Enter: CUSTOM1

 1=  92.0˚ for  0:30

    +

˚C / cycle:  + 1.2
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As for Inc, the temperature step being modified appears on the second
line of this screen. The plus sign on the third line means that the screen is
set up to enter progressive lengthening of hold time. Press «–» to switch
to a minus sign, allowing entry of a progressive shortening of hold time.
Press «Cancel» to change back to a plus sign.

Enter the numerical value of the increase or decrease in hold time (1.0 is
used in the example below):

Press «Proceed». The Ext value just entered will move to the third
line of the screen, and a confirmation menu will be displayed on the
last line:

Select one of the displayed choices, then press «Proceed»:

• Yes accepts the Ext value and displays the Enter Menu again. Use the
Enter Menu to enter the next step in the program.

• No allows reentry of the Ext value.

• Option  displays the Options Menu again. Use the Options Menu to
enter another option for the step.

Entering a Beep Option
To enter a beep, select Beep from the Options Menu for a temperature
step or a ramp step, then press «Proceed». The word “Beep” will be dis-
played on the third line of the screen, and a confirmation menu will be
displayed on the last line:

Select one of the displayed choices, then press «Proceed»:

• Yes  accepts the Beep option and displays the Enter Menu again. Use

Enter: CUSTOM1

 1=  92.0˚ for  0:30

    +

Sec / cycle:  +  1

Enter: CUSTOM1

 1=  92.0˚ for  0:30

    +  1 sec / cycle

OK? _YES  No  Option

Enter: CUSTOM1

 1=  92.0˚ for  0:30

    Beep

OK? _YES  No  Option
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the Enter Menu to enter the next step in the program.

• No  cancels the Beep option.

• Option displays the Options Menu again, if a temperature step is
being modified. Use the Options Menu to enter another option for
the step. (Option will not be displayed if a ramp step is being modi-
fied, since Beep is the only option available for ramp steps.)

Revising During Programming
To change values in a program you are entering, follow the procedures
described below. This editing method should be used to change just a
few values at a time. To make many changes, or to delete or add entire
steps, use Edit mode (see chapter 7).

To Change the Last Value Entered or Menu Option
Chosen
Press «Cancel». The choice just made will be cancelled, so that another
value may be entered or another menu option chosen. Press «Proceed»
after changing a value, so that the program will accept it.

To Change All the Values in the Step Being Entered
Repeatedly press «Cancel». Each time you press the key, the cursor will
move backward through the values for the step, deleting the values as it
moves. When all values for the step have been deleted, enter new val-
ues, or press «Cancel» one more time to display the Enter Menu for the
step. At this point you can change the step to a different type.

To Change Values for Earlier Steps in the Program
Repeatedly press «Cancel» until the Enter Menu for the step you are
working on is displayed. Press «Cancel» one more time to display a list
of all steps entered so far. The list will show the step number and the
values for each step, including any options chosen. The last-entered steps
will be displayed first:

Enter: CUSTOM1

 3=  55.0˚ for  0:30

 4=  72.0˚ for  1:00

 5=
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At this point, you can choose to change selected values in program steps,
to add an option, to enter Edit mode, or to delete the entire program.

Press the «Select» keys to scroll through the program. The left «Select»
key moves the cursor backward through the steps, and the right «Se-
lect» key moves it forward.

• To change selected values or add an option: To change a value, move
the cursor to it, then press «Cancel». Enter the new value, then press
«Proceed». If you change your mind, press «Cancel» again; the de-
leted value will be restored.

To add an option to a step, move the cursor to the step number, then
press «Proceed». The Edit Menu will be displayed:

Select Option, then press «Proceed», and follow the procedure for
adding an option. To abandon the Edit Menu and return to the list of
program steps, press «Cancel».

• To enter Edit mode: Move the cursor to the number of the step you
wish to edit, then press «Proceed». See chapter 7 for information on
entering Edit mode. If you do not wish to enter Edit mode, press «Can-
cel». The screen will return to the list of program steps.

• To delete the program: Position the cursor on any step number and
press «Cancel». A cancellation confirmation screen will be displayed.

Select Yes, then press «Proceed». The program will be deleted, and
the Main Menu will be displayed.

Deleting a Program
To delete a program after at least one complete step has been entered, see
“Revising During Programming,” (p. 6-14).

To delete a program before one complete step has been entered, repeat-
edly press «Cancel». The cursor will move backward through the step’s

Enter: CUSTOM1

 2=   92.0˚ for 0:40

      _EDIT   Insert

Step: Option  Delete

Enter: CUSTOM1

Cancel program?

     _YES   NO
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values, deleting them as it goes. When all values have been deleted, keep
pressing «Cancel» to move backward through Enter mode screens until
the Main Menu reappears, at which point you can begin a new program.

Keeping a Permanent Record of Programs
Occasionally in the course of repairing a  defective DNA Engine, it is
necessary to replace the chip that stores all custom user protocols. To
avoid losing your protocols in such an event, always maintain an up-to-
date record of them. Protocols may be printed out using the List utility
(see chapter 8), stored on a computer using the DNA Engine Driver Soft-
ware, or written down in a notebook.
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Editing a Stored Program
The DNA Engine’s editing tools, available through Edit on the Main Menu,
make it easy to extensively edit stored programs by

• Changing individual values in program steps,

• Adding new steps,

• Deleting steps, and

• Adding options to temperature and ramp steps.

Note:Note:Note:Note:Note: The editing tools do not include a renaming function. To re-
name a program, see “Renaming a Program,” chapter 8.

Initiating Editing
To initiate editing, select Edit from the Main Menu, then press «Pro-
ceed». One of two types of screen will be displayed, depending on
whether your programs have been stored in the <MAIN> folder or in
custom folders.

• If all programs have been stored in <MAIN>:

The screen will list the contents of <MAIN>:

Select the program to be edited, then press «Proceed».

• If programs have been stored in custom folders:

The screen will list all the folders residing in the machine:

Select the folder containing the program, then press «Proceed». A list
of all programs in the folder will be displayed. Select the program to
be edited (CUSTOM1 is used in the following and all succeeding ex-
amples in this chapter), then press «Proceed».

In either instance, after you press «Proceed», the first editing screen will
be displayed (see next section).

Edit:

_<MAIN>  <FOLDER1>

 <FOLDER2>

Edit:      <MAIN>

_CUSTOM1   CUSTOM2

 CUSTOM3   QUIKSTEP

 2-STEP    3-STEP
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Tip:Tip:Tip:Tip:Tip: To retain the original  version of a program, copy the program
(see “Copying a Program,” chapter 8), and then edit the copy.

Editing the Program
The first editing screen displays all three temperature control methods.
The program’s current temperature control method is displayed in all-
capital letters:

Select a different temperature control method if desired, then press «Pro-
ceed» The first three lines of the program will be displayed:

Use the «Select» keys to scroll up and down through the program. The
cursor will progressively move to the step number and the individual
values for each step.

To change an individual value in a step, position the cursor on it and
type the new value, then press «Proceed». The new value will be dis-
played on the screen. To cancel a change, press «Cancel». The original
value will be restored.

To add or delete a step, or to modify a step with an option, position the
cursor on the step number, then press «Proceed». The Edit Menu will be
displayed for that step:

• Edit displays the previous screen again, but with the cursor positioned
on the first value for the step, so that it may be changed.

• Insert allows a step to be added before the displayed step.

• Delete deletes the displayed step.

• Option allows an option to be added to the displayed step if it is a
temperature or a ramp step.

Edit: CUSTOM1

Control method:

    Block    Probe

    _CALCULATED

Edit: CUSTOM1

 2=  63.0˚ for  1:00

      _EDIT   Insert

Step: Option  Delete

Edit: CUSTOM1

_1=  92.0˚ for  0:10

 2=  63.0˚ for  1:00

 3=GoTo 1,  24 times

✔
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Inserting a New Step

To insert a new step, select Insert from the Edit Menu, then press «Pro-
ceed». The Enter Menu will be displayed for the new step (a new step 2
is added in the example below):

Use the Enter Menu to create the new step (see “Entering the Program’s
Steps,” chapter 6). When the step is complete, select Yes from the confir-
mation menu, then press «Proceed». The program being edited will be
displayed again, with the new step appearing among the listed steps.

Deleting a Step

To delete a step, select Delete from the Edit Menu, then press «Proceed».
The step will immediately be deleted, and the program being edited will
be displayed again, minus the deleted step.

To cancel a deletion, see “Cancelling Editing Changes,” p. 7-5.

Note:Note:Note:Note:Note: Be careful when using Delete. Once a step has been deleted, it
cannot be recovered without abandoning all editing changes that have
been made in the program. This could be inconvenient if the program
has been extensively edited.

Adding an Option

To add an option to a step, select Option from the Edit Menu, then
press «Proceed». The option menu will be displayed for the step. Add
the desired option to the step (see “Modifying a Program Step with
the Options,” chapter 6). When the option is complete, select Yes from
the confirmation menu, then press «Proceed». The steps of the pro-
gram being edited will be displayed again, with the new option ap-
pearing in the list.

Saving an Edited Program
To save an edited program, use the right «Select» key to scroll to the End
step of the program. Position the cursor on the number for the step, then

Edit: CUSTOM1

Step 2= _TEMP  GoTo

         Ramp  End
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press «Proceed». A line allowing the editing session to be ended will be
displayed on the last line of the screen:

• End saves the changes and displays the Main Menu. This ends the
editing session.

• Insert allows another step to be added just before the End step.

Cancelling Editing Changes
To cancel all editing changes made to a program, use the «Select» keys to
move the cursor to any step number, then press «Cancel». A cancellation
confirmation screen will be displayed:

Select Yes, then press «Proceed». All editing changes will be abandoned,
and the Main Menu will be displayed.

Edit: CUSTOM1

Cancel changes?

     _YES   No

Edit: CUSTOM1

 2=End

Step:  _END   Insert
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Locating a Stored Program
Many of the DNA Engine’s utilities require you to locate a program stored
in the machine. The actions necessary to do this depend on whether your
programs have been stored in the <MAIN> folder or in custom folders.

• If all programs have been stored in <MAIN>:

The screen will list all the programs that <MAIN> contains:

Select the desired program from this list.

• If programs have been stored in custom folders:

The screen will list all the folders residing in the machine:

Select the folder containing the program, then press «Proceed». A list
of all programs in the folder will be displayed. Select the desired pro-
gram, then press «Proceed».

File Utilities
Use these utilities, available from the Files Menu, to accomplish the fol-
lowing tasks:

• Create folders to store programs in

• Assign passwords to folders

• Copy, delete, rename, or move programs

To display the Files Menu, select Files from the Main Menu, then press
«Proceed»:

Copy:      <MAIN>

_CUSTOM1   CUSTOM2

 QUIKSTEP  2-STEP

 3-STEP    EXTEND

Copy:

<MAIN>    <FOLDER1>

<FOLDER2> <FOLDER3>

Files:

_COPY      Delete

 Move      Rename

 Folder    Secure
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Creating a Folder

The DNA Engine’s memory can hold up to 11 folders, including the
<MAIN> folder. New programs are placed in the <MAIN> folder by de-
fault unless a different folder is specified.

To create a folder, select Folder from the Files Menu, then press «Pro-
ceed». A naming screen will be displayed:

Name the folder, using the instructions found under “Naming the Pro-
gram” in chapter 6, then press «Proceed». The name will be assigned to
the new folder, the folder will be stored, and the Main Menu will be dis-
played.

Assigning a Password to a Folder
Protocols in a password-protected folder cannot be edited, renamed, or
deleted, nor can new protocols be placed in the folder without the pass-
word. Users without knowledge of the password can still run, copy, and
view a program.

Note:Note:Note:Note:Note: A password cannot be assigned to the <MAIN> folder.

To assign a password to a folder, select Secure from the Files Menu, then
press «Proceed». A list of all folders in the machine will be displayed.
Select the desired folder (other than <MAIN>), then press «Proceed».
The password assignment screen will be displayed:

Valid passwords consist of numbers up to four digits long. For passwords
of three digits or less, press «Proceed» after the password has been en-
tered. Passwords four digits long will be automatically accepted as soon
as typed, and the Main Menu will be displayed.

Secure: <FOLDER1>

New password: _

New Folder:

Name: A
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Passwords can be changed at any time. Follow the steps described above
to select the desired folder, then press «Proceed». A screen asking for the
old password will be displayed:

Enter the old password, then press «Proceed». The password assignment
screen be displayed. Enter the new password, then press «Proceed». The
new password will be assigned to the folder, and the Main Menu will be
displayed again.

Deleting a Folder
A  folder must be empty before it can be deleted. After all programs have
been moved or deleted from the folder, select Delete from the Files Menu,
then press «Proceed». A list of all folders in the machine will be displayed.
Select the folder to be deleted, then press «Proceed». A confirmation screen
will be displayed:

Select Yes, then press «Proceed». The folder will be deleted, and the Main
Menu will be displayed.

To cancel the deletion, press «Cancel», or select No and press «Proceed».

Copying a Program
The copy utility copies a program and gives the copy a new name. Cop-
ies can be placed in the original folder or a new one.

To copy a program, select Copy from the Files Menu, then press «Pro-
ceed». Locate the program to be copied (see “Locating a Stored Program,”
p. 8-2), then press «Proceed». If more than one folder of programs is
present in the machine, a screen allowing you to specify the folder the
program will be copied to will be displayed:

Secure: <FOLDER1>

Old password: _

Copy CUSTOM1 to:

_<FOLDER1> <FOLDER2>

 <FOLDER2>

Delete: <FOLDER1>

Delete empty folder?

     –YES   No
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Select a folder to copy the program to, then press «Proceed». A naming
screen will be displayed:

Name the copied program (see “Naming the Program,” chapter 6), then
press «Proceed». The program will be copied to the specified folder un-
der the new name, and the Main Menu will be displayed.

Renaming a Program
To rename a program, select Rename from the File Menu, then press «Pro-
ceed». Locate the program to be renamed (see “Locating a Stored Pro-
gram,” p. 8-2), then  press «Proceed». A naming screen will be displayed:

Name the new program (see “Naming the Program,” chapter 6), then
press «Proceed». The program will be renamed and stored, and the Main
Menu will be displayed.

Moving a Program
To move a program, select Move from the Files Menu, then press «Pro-
ceed». Locate the program to be moved (see “Locating a Stored Pro-
gram,” p. 8-2), then press «Proceed». A screen listing all folders will be
displayed. Select the folder the program should be moved to, then press
«Proceed». The program will be moved to the new folder, and the Main
Menu will be displayed.

Deleting a Program
To delete a program, select Delete from the Files Menu, then press «Pro-
ceed».  Locate the program to be deleted (see “Locating a Stored Program,”
p. 8-2), then press «Proceed». A confirmation screen will be displayed:

Copy CUSTOM1 to:

New name: A

Delete:  CUSTOM3

Delete program?

     _YES   No

Rename: CUSTOM1

New name: A
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Select Yes, then press «Proceed». The program will be deleted, and the
Main Menu will be displayed.

To cancel the deletion, press «Cancel», or select No and press «Pro-
ceed».

 List Utilities
Use these utilities, available under List, to accomplish the following task:

• View and print program steps

Viewing a Program in the LCD Window
To view a program in the LCD window, select List from the Main Menu,
then press «Proceed». Locate the program to be viewed (see “Locating a
Stored Program,” p. 8-2), then press «Proceed». What happens next de-
pends on whether a printer is connected to the DNA Engine.

• If a printer is connected:

A screen will be displayed asking whether the program should be
sent to the printer:

Select No, then press «Proceed». The program will be listed in the
LCD window. The first listed screen will show the program’s control
method. Press «Proceed» to view subsequent screens listing each
program step, including any options. Use the «Select» keys to scroll
up or down through the steps one line at a time. To return to the
Main Menu, press «Cancel» at any time, or press either the right «Se-
lect» key or «Proceed» when the last step appears on the screen.

• If a printer is not connected:

The program will immediately be listed in the LCD window. You will
not be given the option of printing at all.

Note:Note:Note:Note:Note: Listed programs cannot be edited. To edit programs, select Edit
from the Main Menu (see chapter 7).

List: CUSTOM1

Printer output?

      Yes  _NO
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Printing a Program
First ensure that the DNA Engine is connected to a printer. If no printer is
connected, you will not be given the option of printing at all. The DNA
Engine’s parallel interface is compatible with most serial and laser printers,
the Epson® LX-810 dot-matrix printer parallel interface, and dot-matrix print-
ers using interfaces similar to the Epson’s. Use a standard DB-25/Centronics
parallel interface cable to connect the DNA Engine’s parallel port to the
printer’s parallel port. A null-modem serial cable will usually be required to
connect the DNA Engine’s serial port to a printer’s serial port.

Use the Setup utilities to choose a printer port for the DNA Engine (see
“Choosing a Printer Port,” p. 8-8).

Select List from the Main Menu, then press «Proceed». Locate the program
to be printed (see “Locating a Stored Program,” p. 8-2), then press «Pro-
ceed». The screen asking whether the program should be sent to the
printer will be displayed (see above). Select Yes, then press «Proceed».
The program will be printed.

Setup Utilities
Use these utilities, available from the Setup Menu, to accomplish the
following tasks:

• Choose a remote port and a printer port

• Choose a temperature control method for the Hot Bonnet’s heated lid

• Look up the DNA Engine’s software version number

To display the Setup Menu, select Setup from the Main Menu, then press
«Proceed»:

Choosing a Remote Port
To choose either the serial port or the IEEE-488 port, select Remote from
the Setup Menu, then press «Proceed». The port selection screen will be
displayed:

Remote:

 Serial   _IEEE-488

Setup:

_REMOTE    Printer

 Lid       Version
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The cursor will be positioned at the port currently in use.

To choose the serial port, select Serial, then press «Proceed».  The cursor
will move to Serial, and a line allowing a baud rate to be specified will be
displayed on the last line of the screen:

Select a baud rate, then press «Proceed». The remote port assignment
will change to serial, and the Main Menu will be displayed.

To choose the IEEE-488 port, select IEEE-488, then press «Proceed».
The cursor will move to IEEE-488, and a line allowing the DNA En-
gine to be assigned an IEEE-488  address will be displayed on the last
line of the screen:

The machine’s current address will be displayed. To change it, enter a
number from 0–30, then press «Proceed».  The remote port assign-
ment will change to IEEE-488,  the address number will be assigned
to the machine, and the Main Menu will be displayed.

NoteNoteNoteNoteNote: Do not choose 0 for the machine address unless the DNA Engine
will be a controller in a network (see chapter 9).

Choosing a Printer Port
To choose a printer port, select Printer from the Setup Menu, then press
«Proceed». The port selection screen will be displayed:

Select the desired port, then press «Proceed». If serial was chosen, specify
the printer’s baud rate as for “Choosing a Remote Port” (p. 8-7).

Printer:

 Parallel _SERIAL

Printer:

_SERIAL    IEEE-488

Baud: 9600 2400_1200

Printer:

 Serial   _IEEE-488

Address (0-30): 0
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Choosing a Minimum Block Temperature for the Hot
Bonnet
To set a minimum block temperature below which the Hot Bonnet will
automatically turn off, select Lid from the Setup Menu, then press «Pro-
ceed». The following screen will be displayed:

Lid:

Mode     _MINIMUM

Select «MINIMUM» and press «Proceed».  The folowing screen will be
displayed:

Lid Minimum:

   Turn off heated

    lid below: 23° C

Use the keypad to enter the temperature, then press «Proceed» to enter
the value and return to the main menu.

Choosing a Temperature Control Mode for the Hot
Bonnet
Two temperature control modes are available for the Hot Bonnet:

• Tracking: Offsets the temperature of the heated inner lid at least a
specified number of degrees Celsius in comparison to the tempera-
ture of the sample block.

• Constant: Keeps the inner lid at a specified temperature (˚C).

The DNA Engine is set for the tracking mode at the factory, using an
offset of 5˚C, which should be adequate for most reactions. The constant
mode is provided for unusual reactions requiring the inner lid to be hot
at all times. When using the constant mode, specify a lid temperature at
least 10˚C higher than any temperature used in the protocol; we suggest
105˚C.

To choose a control mode, select Lid from the Setup Menu, then press
«Proceed».  The following screen will appear.

Select «Mode», then press «Proceed» (to select a minimum block  tem-
perature, see “Choosing a Minimum Block Temperature for the Hot Bon-
net,” above).

Lid:

_MODE  Minimum
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The mode currently in use will be selected in the screen; select a different
control mode if desired, then press «Proceed» to enter the mode and re-
turn to the main menu.

If the tracking mode is chosen, a lid offset (up to 45˚C above the block,
but not to exceed 110˚C) must be specified. A line for this will appear at
the bottom of the screen: “Lid offset ˚C: 15.” If the constant mode is cho-
sen, a lid target temperature (up to 110˚C) must be specified. A line for
this will appear at the bottom of the screen: “Lid target ˚C:   _.” In either
case, enter a number, then press «Proceed».  The tracking control mode
will be implemented, and the Main menu will be displayed.

Determining the Software Version Number
At times it is necessary to determine the version number of the software
installed in the DNA Engine (e.g., to report a problem to MJ RESEARCH).
To do this, select Version from the Setup Menu, then press «Proceed».
The current version number will be displayed:

The top line reports the software version number (1.1L in the example).
The other two lines refer to the four “pages” that the software has been
broken into and their associated versions (L in the example).

MJ RESEARCH periodically updates the DNA Engine’s software to incor-
porate new features or allow new Alpha units to be used. Most upgrades
are available free of charge for units under warranty and may be installed
into a DNA Engine electronically from a desktop computer. Contact your
MJ RESEARCH sales representative or an authorized distributor for details.
Occasionally upgrades may require a hardware change. These upgrades
require return of the DNA Engine base to MJ RESEARCH or an authorized
distributor.

Version:        1.1L

 CTRL L    EXEC L

 USER L    COMM L
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Overview of Networking
Up to 15 machines consisting of any combination of DNA Engines and
DNA Engine Tetrads may be networked, with or without a computer as
the controller. When networking with a computer, all the machines are
controlled from the computer’s keyboard. When networking without a
computer, a specially designated DNA Engine controls the other machines
in the network. Any combination of single- and dual-block Alpha units
may be loaded into networked machines, and different protocols can be
run independently on them.

Networked machines can help save time for a busy laboratory. For ex-
ample, in a DNA Engine–controlled network, protocols can be entered
into the controlling machine and then be run on all the other machines
connected to the network.

Networking Machines Without a Computer

Connecting the Machines
Connect DNA Engines and DNA Engine Tetrads via the IEEE-488 port on
the back of each machine (see figs. 2-3 and 12-4), using high-quality cables.
Although several connection configurations are possible, we recommend a
simple daisy chain or star pattern. The DNA Engine’s IEEE-488 interface is
fully compatible with both the IEEE-488.2 and the IEEE-488.1 standards.

Assigning Address Numbers to Machines
Each machine must have a unique address number, which is assigned from
its control panel. Address numbers cannot be assigned from the controller.

To assign an address number to a machine, select Setup from the Main
Menu, then press «Proceed». The Setup Menu will be displayed:

Select Remote, then press «Proceed». A screen allowing choice of a port
will be displayed:

Remote:

_SERIAL  IEEE-488

Setup:

_REMOTE    Printer

 Lid       Version
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Select IEEE-488, then press «Proceed». The remote addressing screen will
be displayed:

Enter an address number for the machine. Set the controller DNA Engine’s
address to 0. Give the other machines in the network any number from 1
to 30. Press «Cancel» to delete a number and enter a new one.

Running a Protocol on Networked Machines
To run a protocol on networked machines, use the controller to select a
protocol (see “Choosing a Stored Protocol to Run,” chapter 5), then press
«Proceed». The network screen for the controller will be displayed:

The protocol will be identified on the top line (2-STEP in the example above).
The single asterisk in the upper right-hand corner indicates that a single-
block Alpha unit is loaded into the controller. “Local” indicates that this is
the controller’s network screen, and “96V“ indicates the type of Alpha unit
loaded into the controller.

If a dual-block Alpha unit is loaded into the controller, press «Proceed»
until the letter designating the desired block is displayed after the aster-
isk in the upper right-hand corner of the screen. The letter A designates
the right-hand block, and the letter B the left-hand one (e.g., *A, *B).

To run the protocol on the controller’s block, press «Proceed». One or
more screens for setting up the protocol’s temperature control method
will be displayed (see “Running a Protocol,” chapter 5). When these
screens have been worked through, the protocol will begin running.

To run the protocol on a different machine’s block, press «Block» until
the screen identifies the desired block (22 in the example below):

Remote:

 Serial _IEEE-488

Address (0-30): 0

Run: 2-STEP   on  *

Block: Local (96V)

Run: 2-STEP   on  22

Block: Remote 60V
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The machine’s address number will be identified in the upper right-hand
corner of the screen. “Remote” indicates that this is the network screen
for a slave unit, and “60V” indicates the type of Alpha unit that has been
selected. The status light for the selected block will flash on the control
panel of the machine holding the block.

If the the right or left block of a dual-block Alpha unit has been selected,
an A or a B will appear after the address number (e.g., 7-3A for the right-
hand block in a dual-block Alpha unit loaded into quadrant 3 of a DNA
Engine Tetrad at address 7.  See figure 12-1 for a diagram of the layout of
quadrants in the Tetrad).

Press «Cancel» at any time to abandon the selection process and display
the Main Menu again.

When the desired block is identified in the LCD window, press «Proceed».
When you have worked through the screens that set up the protocol’s tem-
perature control method, the protocol will begin running.

The protocol’s runtime screen will appear on the controller’s LCD win-
dow. The LCD window of the machine holding the active block will con-
tinue to show whatever screen it was displaying before the protocol be-
gan running.

Press «Block» to display the Main Menu on the controller again. Repeat
the procedure to run protocols on other networked blocks. Press «Block»
on the controller to progressively display the runtime screens of all net-
worked blocks that are running protocols.

While protocols are running, other DNA Engine functions (Edit, Enter,
Files, etc.) can be accessed on any individual machine in the network,
from that machine’s front panel.

Networking Machines with a Computer
Networked machines may be conveniently controlled by a computer us-
ing DNA Engine Driver software, which allows you to

• Read and run protocols on any networked machine

• Monitor block temperatures on a real-time graphical display

• Save runtime data to the hard drive for later viewing in spreadsheet
or graphical format

• Verify results and keep records of runs

Contact MJ RESEARCH or an authorized distributor if you do not already
have a copy of this software. A complete manual is provided with the
software. Also available from MJ RESEARCH is a list of ASCII commands
used to communicate with DNA Engines and DNA Engine Tetrads, which
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may be used to write your own driver software.

A computer-controlled network can be connected via IEEE-488 cables or
RS-232 (serial) cables. In either case, the computer acts as the controller
of the network and uses the driver software to communicate with the
networked machines.

Creating a Computer-Controlled IEEE-488 Network
To connect DNA Engines and DNA Engine Tetrads in a computer-con-
trolled IEEE-488 network, the computer must be equipped with an IEEE-
488 (GPIB) interface card (contact National Instruments, MJ RESEARCH, or
an authorized distributor for information about purchasing this card).
Connect the machines and assign addresses as described under “Net-
working Machines Without a Computer” (p. 9-2). Make sure that none of
the networked machines have been assigned IEEE-488 address 0, as this
will cause communication problems with the computer. Install the MJ
RESEARCH DNA Engine Driver software on the computer, and use it to
control the network.

Creating a Computer-Controlled RS-232 Network
In a computer-controlled RS-232 (serial) network, each machine in the
network is connected directly to the controlling computer via a serial
port. The number of machines that can be included in such a network
thus depends on the number of serial ports available on the controlling
computer. Use high-quality serial cables to connect the serial port on each
machine (see figs. 2-3 and 12-4) to a serial port on the computer. Use the
Setup utilities to configure each machine for serial communications (see
“Choosing a Remote Port,” chapter 8, and select the serial port and the
9600 baud rate). Install the MJ RESEARCH DNA Engine Driver software on
the computer and use it to control the network.
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Cleaning the DNA Engine

Cleaning the Chassis and Block
Clean the outside of the DNA Engine and Alpha unit with a damp, soft
cloth or tissue whenever something has been spilled on it or the chassis
is dusty. A mild soap solution may be used if needed.

Clean block wells with swabs moistened with water, 95% ethanol, or a
1:100 dilution of bleach in water (see the Twin Tower Block Operations
Manual for instructions on cleaning the Twin Tower’s slide slots). If using
bleach, swab wells with water afterward to remove all traces of bleach.
Clean spilled liquids out of the block as soon as possible; dried fluids can
be difficult to remove. Do not clean the block with caustic or strongly
alkaline solutions (e.g., strong soaps, ammonia, bleach at a higher con-
centration than specified above). These will damage the block’s protec-
tive anodized coating, possibly causing electrical shorting.

If you use oil in the block (a practice not recommended by MJ RESEARCH;
see “Using Oil to Thermally Couple Sample Vessels to the Block,” chap-
ter 4), clean the wells whenever the oil has become discolored or contains
particulate matter. Use a swab to determine whether cleaning is needed.
Clean the block with 95% ethanol as described above. Oil buildup must
be prevented. Old oil harbors dirt, which interferes with vessel seating
and diminishes thermal coupling of sample vessels to the block.

Caution:Caution:Caution:Caution:Caution: Do not pour any cleaning solution into the block’s wells
and then heat the block, in an attempt to clean it. Severe
damage to the block, the heated lid, and the chassis will
result.

Cleaning the Air Vents
Clean the air intake and exhaust vents with a soft-bristle brush, a damp
cloth, or a vacuum cleaner whenever dust is visible in them. The air in-
take vents are located on the bottom, lower front edge, and back of the
machine; the air exhaust vents are located on both sides (see figs. 2-1, 2-3,
and 2-4). If these vents become clogged with dust and debris, airflow to the
Alpha unit’s heat sink is hampered, causing performance problems re-
lated to overheating. The air intake vents are particularly likely to collect
dust since their holes are much smaller than those of the air exhaust vents.

Tip:Tip:Tip:Tip:Tip: To prevent problems with overheating, institute a regular pro-
gram of checking for dust buildup, particularly for robotics
installations.

✔
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Cleaning Radioactive or Biohazardous Materials Out
of the Block
When cleaning machines that have been running radioactive or biohaz-
ardous reactions, consult your institution’s radiation safety officer or
biosafety officer regarding cleaning methods, monitoring, and dispos-
ing of contaminated materials.

Changing the Fuses
The circuits in the DNA Engine are protected by two fuses (6.3A fast-
acting, 5 x 20mm). When a fuse blows, the DNA Engine immediately
shuts down and cannot be turned back on. The machine records the event
as a power loss, so if a protocol is running when a fuse blows, the ma-
chine will resume the run when the fuse is replaced and power restored
(see “Resuming a Protocol after a Power Outage,” chapter 5).

Warning:Warning:Warning:Warning:Warning: The DNA Engine incorporates neutral fusing, which means
that live power may still be available inside the unit even
when a fuse has blown or been removed. Never open the
DNA Engine base. You could receive a serious electrical
shock. Opening the base will also void your warranty .

1. Disconnect the power cord from the back of the instrument. Move
the power switch to the “0” (off) position.

2. Insert one corner of a small flat-head screwdriver just under the fuse
plug (fig. 10-1A), and gently pry the plug loose. Pull the plug straight
out as far as it will go, then push it downward to expose the fuses
(fig. 10-2B).

3. Remove both fuses and replace them with new ones (it is impossible to visu-
ally determine which fuse is blown). You may also test the fuses with an
ohmmeter to determine which is defective and replace just that one.

4. Gently press the fuse cover back in place, and reconnect the power cord.

Figure 10-1  A, How to pull out the fuse plug. B, Location of the fuses in the opened plug.

BBBBB

FuseFuse
Fuse plug

AAAAA

Screwdriver

Fuse plug
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Error Messages
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Note: The DNA Engine/Tetrad software is highly sensitive with re-
spect to block and heat-sink errors.  When such errors messages occur,
try restarting the protocol.  If the message fails to reappear, proceed as
usual.
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Problems Related to Protocols
Following is a general description of some common problems related to
the protocols and reaction components in sequencing and amplification
applications. For a more detailed discussion of protocols and reactions,
see Current Protocols in Molecular Biology (F. Ausubel et al., eds., John Wiley
& Sons), specifically chapters 7 (DNA sequencing), 14 (in-situ hybridiza-
tion and immunology), and 15 (polymerase chain reaction).
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Problems Related to Environmental Conditions,
Setup, and Maintenance
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Meet the DNA Engine Tetrad
The DNA Engine Tetrad harnesses four DNA Engines in a single com-
pact machine. Four Alpha units of any type can be loaded into the DNA
Engine Tetrad base, one unit into each “quadrant” of the base. The same
factory-installed and custom protocols can be run on the DNA Engine
Tetrad as on the DNA Engine. Programs can be run independently on
any one Alpha unit or simultaneously on all of them.

The DNA Engine Tetrad’s control panel
is nearly identical to that of the DNA En-
gine. Additional features include a
«Power» key and an array of lights indi-
cating the selection status of the blocks in
the base’s quadrants. There is an A and a
B light for each quadrant since each Al-
pha unit can contain up to two blocks. The
arrangement of the status indicator lights
matches the arrangement of the quadrants
in the base when the DNA Engine Tetrad
is viewed from above (fig. 12-1).

The DNA Engine Tetrad’s power supply has been placed in a separate
housing that is attached by cables to the base, which keeps the base com-
pact and makes it easier to use in robotics installations. The power sup-
ply uses MOSFET transistors to efficiently convert AC input power into
the high-current, low-voltage DC power that the Tetrad requires (see ap-
pendix D for a short explanation of this technology).

Up to 15 DNA Engine Tetrads and DNA Engines can be networked together,
in any combination, but a DNA Engine or a computer must serve as the
controller unit for the network. Networked DNA Engine Tetrads operate
like networked DNA Engines, with a few minor exceptions (explained be-
low). The Power Bonnet remote-controlled heated lid may also be used with
networked DNA Engine Tetrads if the controller is a computer.

Specifications
The DNA Engine Tetrad’s specifications are identical to those of the DNA
Engine except for weight and size (see chapter 2).
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Figure 12-1 Layout of quadrants.
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Layout

Control Panel
(Figure 12-3)

Front View
(Figure 12-2)
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Back View
(Figure 12-4; Alpha units removed)

Bottom View
(Figure 12-5)
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Unpacking and Installing the DNA Engine Tetrad

Packing Checklist
After unpacking the DNA Engine Tetrad, check to see that you have
received the following:

• DNA Engine Tetrad base

• Four Alpha units

• Power supply unit

• 220V power cord set (inside power supply box)

• Four spare fuses

• PTC-200 DNA Engine & PTC-225 DNA Engine Operations Manual (this
document)

• Software request form (US customers only)

• Extended warranty form (US customers only)

• Warranty registration card (US customers only)

If any of these components are missing or damaged, contact MJ RESEARCH

or the authorized distributor from whom you purchased the DNA En-
gine Tetrad to obtain a replacement. Please save the original packing
materials in case you need to return the Tetrad for service. See appendix
E for shipping instructions.

Installation
The DNA Engine Tetrad requires minimal assembly: installing the Alpha
units (see chapter 4) and connecting the signal and power cables to the
back panel of the base.

Connecting the Cables

The signal and power cables running from the DNA Engine Tetrad’s
power supply (fig. 12-4) must be connected to the base, and the power
supply must be plugged into an electrical outlet.

Warning:Warning:Warning:Warning:Warning: Disconnect the power supply from the wall outlet before
connecting or disconnecting the signal or power cable.
The power supply is capable of generating high-current
DC power. High-current circuits should never be con-
nected or disconnected when electrical power is present;
electrical arcs may result, which can damage the power
supply and pose a hazard of electrical shock.
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The signal and power cables terminate in twist-lock plugs. To screw a
plug in, first make sure the power supply is not plugged into an outlet.
Press the plug into the socket, and twist it to the right. A snap will be felt
when the plug completely seats in the socket; a faint click is also audible
when the plug to the power cable fully seats.

The signal and power cables are joined at their power supply end by a
single connector that plugs into the power supply. This connector is
housed in a protective metal cage screwed onto the back of the power
supply.

Note:Note:Note:Note:Note: Do not open the protective housing; there are no user-service-
able parts within.

Power Supply Requirements
The DNA Engine Tetrad requires 10A@200–240VAC, 50/60 Hz. The unit
is not designed to operate on the ordinary 100V–120V household power
commonly supplied in North America and Japan. The DNA Engine Tet-
rad can use current in the specified range without adjustment, so there is
no voltage-setting switch.

Environmental Requirements
The requirements for safe operation of the DNA Engine Tetrad are the
same as those of the DNA Engine (see chapter 3).

Air Supply Requirements
The air supply requirements for the DNA Engine Tetrad are the same as
those of the DNA Engine (see chapter 3).

Robotics Installation Requirements
Robotics installations of DNA Engine Tetrads require special attention to
airflow and air temperature. Typically in these installations, DNA En-
gine Tetrads and other thermal cyclers are crowded into a small area,
along with other heat-generating equipment. Overheating can quickly
occur when many of these machines are operating at once, unless pre-
ventive measures are taken.

Follow the procedures described in chapter 3 to ensure adequate airflow
and an air intake temperature of 31˚C or cooler. Air intake temperature
must be verified by measurement. If none of the troubleshooting proce-
dures outlined in chapter 3 are sufficient to ensure cool-enough air,
install ductwork to the front and rear air exhaust vents, to remove
exhausted air. Attach ductwork using the screws to the right and left
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of the air exhaust vents on the front and back of the DNA Engine
Tetrad (fig. 12-2). These screws may be replaced with longer ones, as
long as they are M4 x 0.7 screws.

Operating the DNA Engine Tetrad

Turning the DNA Engine Tetrad On
First, make sure Alpha units are installed in all four quadrants. An in-
terlock switch prevents the DNA Engine Tetrad from operating if fewer
than four Alpha units are installed.

Turn the DNA Engine Tetrad on with the «Power» key located at the
lower right of the control panel.

Operating Alpha Units
Alpha unit installation, removal, and general operation are the same as
for the DNA Engine (see chapter 4).

Running Protocols on the DNA Engine Tetrad

Running Separate Protocols by Block
Choose a protocol (see chapter 5). A screen identifying the protocol (2-
STEP in the examples below), the Alpha unit type (96V), and the quad-
rant number of the block the protocol will run on (1) will be displayed:

If a dual-block Alpha unit is present in the identified quadrant, an A or a
B will appear after the quadrant number (e.g., 1A).

Protocols are initially assigned to the first block available in the DNA
Engine Tetrad, in numerical order of quadrants. To run the protocol on a
different block, press «Block» until the quadrant number of the desired
block is displayed in the screen’s upper right-hand corner. The status
light of the selected block will flash. When a single-block Alpha unit is
selected, only the A light flashes. When a dual-block Alpha unit is se-
lected, either the A or the B light flashes, depending on the block chosen.

Run: 2-STEP    on  1

Block: 96V
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When the desired block has been selected, press «Proceed» to run the protocol.

Note: To run different protocols concurrently, press «Block» to return to
the main screen, and select a new protocol and a new block as de-
scribed in this section.  Any protocols already initiated will continue to
run.

Running the Same Protocol on All Blocks
If all the Alpha units installed in the DNA Engine Tetrad have the same
type of block (i.e., each has the same number of wells, or four Twin Tow-
ers are loaded) and no protocols are currently running on any of them,
the same protocol (including an instant incubation) may be run on all of
the blocks at once.

To do this, select a protocol (or press «Instant» to run an instant incuba-
tion), then press «Block» until All appears in the upper right-hand corner
of the displayed screen:

The status indicator lights for all of the sample blocks will be flashing green.
Press «Proceed» to run the protocol on all the blocks simultaneously.

Running an Instant Incubation
Instant incubations are run in the same way as for the DNA Engine (see
chapter 5). The incubation is initially assigned to the first available block in
numerical order of quadrants; press «Block» to assign it to a different block,
or to all of them (if the same type block is present in all four quadrants).

Cancelling Protocols
Press «Block» to select the block that is running the protocol to be cancelled,
then press «Cancel». A cancellation confirmation screen will be displayed:

Run: 2-STEP    on 2B

STOP 2-STEP on 2B?

       Yes  _NO

Run: 2-STEP   on ALL

Block: 96V
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Select Yes, then press «Proceed». A screen announcing the cancellation
and citing the total time for the run will be displayed:

Programming the DNA Engine Tetrad
The DNA Engine Tetrad is programmed in the same way as the DNA
Engine (see chapter 6).

Networking the DNA Engine Tetrad
Any combination of DNA Engine Tetrads and DNA Engines can be net-
worked, as long as the 15-machine limit is not exceeded and a computer
or a DNA Engine is included to serve as the controller (the DNA Engine
Tetrad cannot serve as controller). See chapter 9 for information on net-
working machines.

Software Required for Networking
A DNA Engine must have software version 1.1J or later in order to control a
network that includes one or more DNA Engine Tetrads. To identify the
software version loaded into a DNA Engine, see “Determining the Software
Version Number,” chapter 8.

Operating Networked DNA Engine Tetrads
Networked DNA Engine Tetrads operate the same as networked DNA
Engines. Each block of a networked DNA Engine Tetrad is designated by
the machine’s IEEE-488 address, followed by the block’s quadrant num-
ber and an A or a B if a dual block is involved. For example, the designa-
tion for a single-block Alpha unit present in quadrant 1 of machine 17 is
17-1. The designation for block B in a dual-block Alpha unit present in
quadrant 2 of the same machine is 17-2B.

Using the Utilities for the DNA Engine Tetrad
The DNA Engine Tetrad has the same utilities as the DNA Engine (see
chapter 8).

Run: 2-STEP    on 2B

  PROGRAM CANCELED

Total time:     1:10
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Troubleshooting the DNA Engine Tetrad
The Tetrad is subject to the same problems with operations, protocols,
and reaction results as the DNA Engine (see chapter 11).

Maintaining the DNA Engine Tetrad

Cleaning
Clean the DNA Engine Tetrad according to the instructions in chapter 10
for cleaning the DNA Engine.

Changing the Fuses
Each quadrant of the Tetrad is protected by a fuse mounted in a plug on
the back panel of the base (fig. 12-6). Blown fuses may be replaced by any
15A fast-acting fuse (0.25” x 1.25”3AB or 3ABC).

To replace a fuse, first unplug the power supply from the wall. Twist the
fuse cap a quarter turn to the left and pull out the fuse plug. Replace the
blown fuse. Press the plug back into its socket, and twist it a quarter turn
to the right to seat it. The plug is spring-loaded, so firm pressure may be
required.

Warning:Warning:Warning:Warning:Warning: The DNA Engine incorporates neutral fusing, which
means that live power may still be available inside the
unit even when a fuse has blown or been removed. Never
open the DNA Engine Tetrad base; you could receive a
serious electrical shock. Opening the base will also void
your warranties.

Quadrant 4 Quadrant 1

Quadrant 2Quadrant 3

Figure 12-6  Quadrant assignments for fuses.
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The Remote Alpha Dock
System

About the Remote Alpha Dock System,   13-2
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Operation,    13-6
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About the Remote Alpha Dock System
The Remote Alpha Dock system is designed to add flexibility to the in-
stallation and operation of the MJ Research PTC-200 DNA Engine and
PTC-225 DNA Engine Tetrad.  The system allows Alpha units to be placed
at a distance from the PTC-200 or PTC-225 base, enabling more efficient
use of space and facilitating robotic operation.  The basic system, the RAD-
0200, comprises a Dock Connector, which mounts in the base; and a Re-
mote Alpha Dock, into which the Alpha units are mounted.  The RAD-
0201 contains, in addition, a fan power supply and three “daisy chain”
(series) cables, allowing the cooling fans for up to four Remote Docks to
run off a single AC outlet.  Additionally, the fan power supply along with
the cables to run up to four Remote Alpha Dock fans from a single ther-
mal cycler base can be purchased separately, as RPS-0200.

Figure 13-1 The Remote Alpha Dock with Alpha unit mounted
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The Remote Alpha Dock System

Packing checkist
• One Dock Connector

• One Remote Alpha Dock

• One multi-pin power cable

• One multi-pin data cable

• One fan power supply (RAD-0201 only)

• One wall-plug power cord (RAD-0201 only)

• Three round-jack power cords (RAD-0201 only)

• Product registration card (US  only)

• Extended warranty application (US only)

Requirements
Environment
The Remote Alpha Dock System allows for custom installations.  The
following placement configurations are recommended by MJ Research.
• Remote Docks with mounted Alpha units may be configured in any

horizontal orientation or array as long as a minimum side clearance
of 10 cm is maintained between the Remote Dock and any wall, bulk-
head, or adjacent Remote Dock unit (this is identical to the PTC-200/
PTC-225 base requirement).  Requirements for motorized lid opera-
tion or for loading or unloading plates may dictate additional clear-
ances.

Figure 13-2 Remote Alpha Dock and Dock Connector,
bottom view.
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Figure 13-3 Attachment of power and data cables

• Remote Docks with mounted Alpha units may be stacked vertically
as long as a minimum bottom clearance is maintained that would be
no less than that resulting from the unit being placed on a solid hori-
zontal platform.    A  minimum top clearance is also required to allow
access to and operation of the Alpha unit lid.

• Remote Docks can be flush-mounted (i.e., with the feet removed) to
facilitate robotic operation, as long as the airway beneath the unit is
equivalent to the airway the unit would have with the feet attached.
Usually  a hole will need to be cut to allow air to flow to the the
cooling fan.  Figure 13-5 is a template for flush-mounting the Remote
Dock.

Power Supply
• The Alpha unit mounted in each Remote Dock is powered from the

PTC-200 or PTC-225 base.
• The Remote Dock’s fan is powered externally, and a power supply is

provided that requires power from 90-250 VAC and 47 to 63 Hz, with
a grounded outlet.

Air Supply
• Alpha units being operated in the remote configuration have no op-

erating constraints that do not also apply to normal operations in the
PTC-200 or PTC-225.

Dock connector Remote dock
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The Remote Alpha Dock System

Figure 13-4 Fan power supply connected in series

Installation
• Turn the Dock Connector upside down, so that the green circuit board

is visible.  Check that the ground lead remains attached at both ends
(fig. 13-1).  Note the two female multi-pin sockets, one labeled
“DATA,” and the other “POWER.”

• Connect the multi-pin power cable’s male end to the female socket
labeled “POWER” and slide the latch to lock the pins in place.

• Both of the data cable’s multi-pin connectors are male: one is labeled
“CONNECTOR DATA” and the other “DOCK DATA.”  Attach the
“CONNECTOR DATA” end to the female connector labeled “DATA”
on the circuit board and slide the latch to lock the pins in place.

• Press both cables firmly into the two strain relief holes on the Dock
Connector’s front side (fig. 13-2).

• Turn the Remote Dock upside down.  You will see a male multi-pin
connector labeled “Power Port” and a female multi-pin connector la-
beled “Data Port” (fig. 13-3).

• Connect the multi-pin power cable’s female end to the connector la-
beled “Power Port” and slide the latch to lock the pins in place.

• Attach the data cable’s “DOCK DATA” end to the connector labeled
“Data Port”  and slide the latch to lock the pins in place.

• Turn both units back over.
• The Dock Connector mounts in the base in the same manner as a

regular Alpha unit (see pp. 4-4 – 4-6).
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• Attach the wall-plug power cord to the fan power supply.
• Attach the fan power supply’s round jack to either of the round con-

nectors on the back of the Remote Dock (fig. 13-4).
• The fan power supply produces sufficient current such that up to

three additional fans can be “daisy chained” to the initial Remote
Dock via the round-jack power cords supplied.  Attach one end of the
cord to the initial unit’s free round connector.  Attach the other end to
either of the round connectors on the back of the next Remote Dock
in the series, and so on (fig. 13-4).

• When the RAD system has been completely set up, connect the fan
power supply’s wall plug to a power source.

Operation
The remote system is transparent to the base unit; i.e., the Dock Connec-
tor allows the base to control the Alpha unit in the Remote Dock as if it
were in the standard configuration.

IMPORTANT: Turn the base unit’s power off when changing the type of
sample block you are using.  Turning the power off resets the base, allow-
ing it to recognize the new block.  If not reset, the base unit assumes that
the previous type of block is installed, resulting in error messages and
procedural faults.
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The Remote Alpha Dock System

Figure 13-5     Flush-mounting template
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Warning:Warning:Warning:Warning:Warning: Operating the PTC-200 DNA Engine or PTC-225 DNA Engine Tetrad before
reading this manual can constitute a personal injury hazard. Only qualified
laboratory personnel trained in the safe use of electrical equipment should op-
erate these machines.

Warning:Warning:Warning:Warning:Warning: Do not open or attempt to repair the PTC-200 DNA Engine or PTC-225 DNA
Engine Tetrad base, the PTC-225 DNA Engine Tetrad power supply, any Alpha
unit, or any accessory to the PTC-200 DNA Engine or PTC-225 DNA Engine
Tetrad. Doing so will void your warranties and can put you at risk for electrical
shock. Return the PTC-200 DNA Engine or PTC-225 DNA Engine Tetrad to the
factory (US customers) or an authorized distributor (all other customers) if re-
pairs are needed.

Warning:Warning:Warning:Warning:Warning: All Alpha unit blocks can become hot enough during the course of normal op-
eration to cause burns or cause liquids to boil explosively. Wear safety goggles
or other eye protection at all times during operation.

Warning:Warning:Warning:Warning:Warning: The PTC-200 DNA Engine and PTC-225 DNA Engine Tetrad incorporate neu-
tral fusing, which means that live power may still be available inside the ma-
chines even when a fuse has blown or been removed. Never open the PTC-200
DNA Engine or PTC-225 DNA Engine Tetrad base; you could receive a serious
electrical shock. Opening the base will also void your warranties.

Caution:Caution:Caution:Caution:Caution: Never remove an Alpha unit from the PTC-200 DNA Engine or PTC-225 DNA
Engine Tetrad with the power turned on and a program running. Doing so can
cause electrical arcing that can melt the contacts in the connector joining the
Alpha unit to the PTC-200 DNA Engine or PTC-225 DNA Engine Tetrad.

Safe Use Guidelines
The PTC-200 DNA Engine and PTC-225 DNA Engine Tetrad are designed to be safe to operate
under the following conditions:

• Indoor use

• Altitude up to 4000m

Appendix A

Safety Warnings and Guidelines



DNA Engine & DNA Engine Tetrad Operations Manual

A-2A-2A-2A-2A-2

• Ambient temperature 5˚–31˚C

• Maximum relative humidity 90%, noncondensing

• Transient overvoltage per Installation Category II, IEC 664

• Pollution degree 2, in accordance with IEC 664

Electromagnetic Interference
The PTC-200 DNA Engine and PTC-225 DNA Engine Tetrad have been tested and found to com-
ply with the limits for a Class A digital device, pursuant to part 15 of the US FCC Rules. These
limits are designed to provide a reasonable protection against harmful interference when the equip-
ment is operated in a commercial environment. These machines generate, use, and can radiate
radiofrequency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of these machines in a resi-
dential area is likely to cause harmful interference, in which case the user will be required to
correct the interference at his or her own expense.

In addition, the PTC-200 DNA Engine and PTC-225 DNA Engine Tetrad designs have been tested
and found to comply with the EMC standards for emissions and susceptibility established by the
European Union at time of manufacture.

FCC Warning
Changes or modifications to the PTC-200 DNA Engine or PTC-225 DNA Engine Tetrad not ex-
pressly approved by the party responsible for compliance could void the user’s authority to oper-
ate the equipment.
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The functional heart of every DNA Engine is a high-performance Peltier-effect heat pump (also
known as a “thermoelectric module”). This solid-state device is manufactured to withstand the
thermal stresses associated with rapidly cycling temperatures.

A thermoelectric module consists of numerous pairs
of crystalline semiconductor blocks precisely sand-
wiched between two layers of ceramic substrate (fig.
A-1). The blocks are of two varieties:  “N-type,” which
has a surplus of electrons in its crystalline structure,
and  “P-type,” which has a deficit of electrons. The two
types are positioned in alternating pairs within the in-
nermost layer of the sandwich.

The two types of blocks are wired together in alternat-
ing pairs. When electrical current is passed through the
blocks, electrons in the N-type blocks and the “holes,”
or empty electron spaces, in the P-type blocks are ex-
cited at one conductor-semiconductor interface, which
absorbs a small amount of heat. The electrons and holes
flow through the crystalline blocks and return to a low-energy state at the other conductor-semi-
conductor interface, with the release of the previously absorbed heat. A thermal gradient of up to
70°C can be generated across the blocks in this manner.

The direction of heat pumping is reversed by reversing the polarity of current flow through the
thermoelectric module, and the amount of heat pumped is changed by changing the amount of
current passed. Both direction and amount of current flow are dictated by a microprocessor in the
Alpha unit, allowing precise control of thermal cycling in the Alpha unit block.

How a Peltier Heat Pump Works

Appendix B

Electron

Hole
N-type 
bismuth 
telluride

N-type 
bismuth 
telluride

Metal conductor

P-type
bismuth
telluride

Ceramic substrate

Power input

Power input

Figure A-1 A thermoelectric module.
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Almost all solid-state electronic devices, including the DNA Engine’s thermoelectric module, re-
quire direct current (DC) for operation. However, electric utilities supply low-Hertz alternating
current (AC), which varies in voltage and frequency from nation to nation. The DNA Engine uses
switching transistors, combined with high-frequency, resonant transformers, to convert the in-
coming AC to DC.

The power supply first chops the AC power into small bursts of energy (over 100,000 per second)
with the aid of high-current switching transistors called MOSFETs (metal-oxide semiconductor
field-effect transistors). The energy bursts are channeled into a high-frequency transformer. By
changing the duration of the bursts that charge the transformer’s magnetic core (pulse-width
modulation), a specific voltage output can be maintained even when the incoming voltage varies
(between 100 and 240 volts in the case of the DNA Engine). Because the incoming power is being
chopped so rapidly, the incoming frequency is unimportant; it can even be DC. Spikes and surges
in the incoming power no longer pose a problem since they are chopped nearly to oblivion. The
addition of resonance to the transformer design gives it extraordinary efficiency. These design
innovations has made the DNA Engine’s power supply small in size, universal in input, and resis-
tant to noise.

Appendix C

How a Switching Power Supply
Works
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Users residing in the United States should follow these instructions for shipping a machine to MJ
RESEARCH for factory repair or an upgrade. Users outside of the United States should send ma-
chines to their distributor, in accordance with shipping instructions obtained from the distributor.

1. Call MJ RESEARCH to obtain a return materials authorization (RMA) number. Machines returned
without an RMA will be refused by the Receiving Department.

2. Thoroughly clean the machine, removing excess oil and radioactive and other biohazardous
substances. To protect the health of our employees, MJ RESEARCH will not repair or upgrade
any machine that is excessively oily or that emits ionizing radiation upon arrival at our fac-
tory. PLEASE ELIMINATE ALL BIOHAZARDS!

3. Pack the machine in its original packaging. If this has been misplaced or discarded, call MJ
RESEARCH to request shipment of packaging materials. You can also request a loaner machine,
which will be provided if available (a rental fee may apply). You can use the loaner’s packag-
ing to return the machine needing repair.

Remove the Alpha unit from the DNA Engine or DNA Engine Tetrad base before shipping. All
warranties are voided if a machine is shipped with an Alpha unit installed. If the Alpha unit
also needs to be shipped, pack it in its original packaging materials.

4. Write the RMA number on the outside of the box.

5. Ship the machine (freight prepaid) to the following address. We recommend you purchase
insurance from your shipper.

Ship to: Repair Department
MJ Research, Inc.
136 Coolidge Ave.
Watertown, MA  02172

Appendix D

Shipping Instructions for US Residents
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Warranties

U.S. Domestic Warranty, Standard
MJ RESEARCH, Inc. warrants NEW MJ RESEARCH BRAND THERMAL CYCLERS (MODELS PTC-
100, PTC-150, PTC-200 & PTC-225) against defects in material and workmanship for a period of
two years from the date of purchase. If a defect is discovered, MJ RESEARCH, Inc. will, at its option,
repair, replace, or refund the purchase price of the THERMAL CYCLER at no charge to the cus-
tomer, provided the product is returned to MJ RESEARCH, Inc. within the warranty period. In no
event will MJ RESEARCH, Inc. be responsible for damage resulting from accident, abuse, misuses, or
inadequate packaging of returned goods.

ANY implied warranties, including implied warranties of the merchantability and fitness for a
particular purpose, are limited in duration to TWO years from the date of original retail purchase
of this product.

The warranty and remedies set forth above are exclusive and in lieu of all others, oral or written,
expressed or implied. No MJ RESEARCH dealer, agent, or employee is authorized to make any modi-
fication, addition, or extension to this warranty, except in the form of the extended warranty out-
lined below.

MJ RESEARCH, Inc. is not responsible for special, incidental, or consequential damages resulting
from any breach of warranty, or under any other legal theory, including downtime, lost samples or
experiments, lost reagents, lost profits, goodwill, damage to or replacement of equipment, prop-
erty, and any costs of recovering or reproducing experimental results and data.

Exclusions: This warranty applies only to machines sold in the U.S.A. Under no circumstance will MJ
RESEARCH ship a repaired or replaced machine, or grant a refund of purchase price, to a user in a nation
in which there was an authorized MJ RESEARCH distributor at the time of purchase. THIS WARRANTY
IS NOT TRANSFERABLE FROM THE ORIGINAL PURCHASER TO A SUBSEQUENT OWNER.
FURTHERMORE, THIS WARRANTY DOES NOT APPLY TO INSTRUMENTS USED OUTSIDE THE
U.S.A., EXCEPT WHEN EXPRESSLY AUTHORIZED IN WRITING BY MJ RESEARCH, INC.

U.S. Domestic Extended Warranty, Optional
MJ RESEARCH, Inc. will offer to each ORIGINAL PURCHASER of an MJ RESEARCH BRAND thermal
cycler the opportunity to purchase an extension of the warranty coverage explained above for an
additional two years. The coverage must be purchased through a purchase order received by MJ
RESEARCH, Inc. within 30 days of receipt of the offer of extended warranty or the offer to renew the
extended warranty. These offers apply only to machines sold and used in the U.S.A.

E-1



Some states OF THE U.S.A. do not allow the exclusion or limitation of incidental or consequential
damages or limitations on how long an implied warranty lasts, so the above limitation or exclu-
sion may not apply to you. This warranty gives you specific legal rights. You may also have other
rights depending upon your state of residence.

All provisions of this warranty are voided if the product is resold, repaired, or modified by any-
one other than MJ RESEARCH or an authorized distributor.
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Appendix F: Factory-Installed Protocols

emaN emaN emaN emaN emaN
lortnoC.pmeT lortnoC.pmeT lortnoC.pmeT lortnoC.pmeT lortnoC.pmeT

dohteM dohteM dohteM dohteM dohteM petS petS petS petS petS emiT&.pmeT emiT&.pmeT emiT&.pmeT emiT&.pmeT emiT&.pmeT

TEKUBECI kcolB 1
2

00:00:0,°4
DNE

NOITAGIL kcolB 1
2

00:00:0,°51
DNE

RH1–°73 kcolB 1
2
3

00:00:1,°73
00:00:0,°4

DNE

RH6–°73 kcolB 1
2
3

00:00:6,°73
00:00:0°4

DNE

°56 kcolB 1
2

00:00:0,°56
DNE

ERUTANED kcolB 1
2

00:50:0,°59
DNE

LIOB kcolB 1
2

00:50:0,°001
DNE

LLIK&TUC kcolB 1
2
3

00:00:1,°73
00:50:0,°07

DNE

Appendix F

Factory-Installed Protocols
Note:  A programmed time of 0:00:00 means “hold at this temperature forever.”



In-1In-1In-1In-1In-1

Index

AAAAA
Accessories. See Power Bonnet
Air supply requirements

ensuring adequate air supply  3-3
Ensuring air is cool enough  3-4
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Chill-out liquid wax  4-7
Cleaning

air vents  10-2
and biohazardous materials  10-3
and radioactive materials  10-3, 4-16
chassis and block  4-16
removing oil from block  10-2
solutions to use  4-16

Condensation in tubes following holds  4-8
Control panel  2-2

keys  4-3
lights  4-3
using  4-3

DDDDD
DNA Engine

running protocols

separately by block  12-7
simultaneosly on all blocks  12-8

DNA Engine Driver Software  9-4
DNA Engine Tetrad

air supply requirements  12-6
Alpha units, operating  12-7
cancelling protocol runs  12-8
cleaning  12-10
connecting power cables  12-5
environmental requirements  12-6
fuses, changing  12-10
general information  12-2
installing  12-5–12-6
instant incubations, running  12-8
layout

back view  12-4
bottom view  12-4
control panel  12-3
front view  12-3

networking  12-9
packing checklist  12-5
power supply requirements  12-6
programming  12-9
robotics installations  12-6
specifications  12-2
troubleshooting  12-10
turning machine on  12-7
utilities for  12-9

Documentation conventions
graphic  iv
terminology  iv
typographic  iv

EEEEE
Electromagnetic interference  A-2
Environmental requirements  3-2–3-3
Error messages  11-2
Extend option. See Programs: options, types of



In-2In-2In-2In-2In-2

DNA Engine & DNA Engine Tetrad Operations Manual

FFFFF
FCC warning  A-2
Fuses

changing  10-3

HHHHH
Hot Bonnet

adjusting lid pressure  4-8–4-9
temperature control methods  8-9

IIIII
Increment option. See Programs: options, types of
Instant incubation  5-10

LLLLL
Layout

back view  2-3
bottom view  2-3
control panel  2-2
front view  2-2

MMMMM
Menus

Edit Menu  7-3
Enter Menu, the  6-6
Files Menu  8-2
Main Menu  4-2
Options Menu  6-11

menus
Setup Menu  8-7

Microseal
"A" film  4-8
'M" sealing mat  4-8
'P' pads  4-14

NNNNN
Networking

general information  9-2
with computer as controller  9-4

setting up an IEEE-488 network  9-5
setting up an RS-232 network  9-5

with DNA Engine as controller  9-2–9-4
assigning address numbers  9-2
connecting machines  9-2
running protocols  9-3

OOOOO
Oil, use of in block. See Sample vessels
Operation

turning machine on  4-2

PPPPP
Packing checklist  3-2
Passwords. See Utilities: files: assigning password to

folder
Peltier effect  C-1
Ports  4-3

IEEE-488  2-3
parallel (printer)  2-3
RS-232  2-3

Power Bonnet  2-4
Power cord

location of jack  2-3
plugging in  3-2

Power supply requirements  3-3
acceptable power cords  3-3

Probe
adding representative sample

calculating amount of oil to add  4-12
choosing type of oil  4-12
how to add oil  4-12

connecting to block  4-13
customizing probe vessel  4-11
detecting faulty  4-13
function of  4-11
layout  4-11
loading into block  4-13
thermistor  4-11

probe
adding representative sample  4-12
silicone oil as representative sample  4-17

Programming
Choosing a temperature control method  6-6
deleting an uncompleted program  6-16
entering steps

beep option  6-14
end step  6-11
extend option  6-13
GoTo step  6-10
Increment option  6-12
ramp step  6-8
temperature step  6-7

general process  6-5
Initiating a program  6-5
modifying block- and probe-control programs

for ca  6-5
modifying programs designed for other ma-

chines  6-5



In-3In-3In-3In-3In-3

Index

Naming a program  6-6
revising during  6-14
setting a lengthy hold time  6-7

Programs
designing  6-2–6-5

choosing temperature control method. See
Temperature control methods
translating protocol into programinto pro-
grams  6-2
using GoTo steps to shorten programs  6-3

editing  7-2, 7-3–7-4
adding an option  7-4
cancelling editing changes  7-5
changing individual values in a step  7-3
changing temperature control method  7-3
deleting step  7-4
inserting new step  7-4
saving edited program  7-4–7-5

finding in machine  5-2, 7-2, 8-2
options
options, types of  6-2, 6-12
program steps, types of  6-2
renaming. See Utilities: file

Protocols
and power failure  5-9
factory-installed  F-1
factory-installed  5-2
manually stepping through  5-8
pausing while running  5-8
printing logs for runs  5-7–5-8

sample log  5-7
running

choosing block to run protocol on  5-3
choosing protocol to run  5-2
reading completion screen  5-6
reading runtime screen  5-5–5-6
setting up temperature control method  5-3
three steps of  5-2

stopping while running  5-9
protocols

adjusting for sample vessel type  4-6

RRRRR
Remote Alpha Dock System

air supply requirements  13-4
environmental requirements  13-3
installation  13-5
operation  13-6
packing checklist  13-3
power supply requirements  13-4

Robotics installation requirements  3-5

SSSSS
Safety

general instructions  1-3
guideline for safe use  A-1
warnings  A-1

Sample vessel
selection chart  4-14

Sample vessels
ensuring good thermal contact  4-10
loading into block  4-9

ensuring good thermal contact  4-9
sealing

Reason for  4-7
with Hot Bonnet and Caps/Film  4-8
with oil or wax  4-7

selection  4-6
0.2-ml tubes  4-6
0.5-ml tubes  4-6
microplates  4-6

Use of oil to improve thermal contact with block
4-10

Self-test  4-2
Setting machine up. See also Alpha units, installing
Shipping instructions  E-1, E-1
Specifications  2-5

DNA Engine Tetrad  2-5
Switching power supply  D-1

TTTTT
Temperature control methods

block control  6-3, 6-4
calculated control  6-3, 6-4
choice of calculated control over probe control

4-11
probe control  6-4

Thermoelectric unit  C-1

UUUUU
Utilities

file
assigning password to folder  8-3–8-4
copying program  8-4
creating folder  8-3
deleting a program  8-5
Deleting folder  8-4
moving a program  8-5
renaming programs  8-5

List  8-6



In-4In-4In-4In-4In-4

DNA Engine & DNA Engine Tetrad Operations Manual

viewing a program in LCD window  8-6
list
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choosing a printer port  8-8
choosing a remote port  8-7
choosing a temperature control method for the
Hot  8-9
determining software version number  8-9



DECLARATION OF CONFORMITY TO APPLY “CE” MARK

MJ RESEARCH, INC. hereby declares that the MJ RESEARCH PTC-200
DNA Engine™ thermal cycler conforms to the following directives and standards:

APPLICATION OF COUNCIL DIRECTIVES:  89/336/EEC & 73/23/EEC

STANDARDS TO WHICH CONFORMITY IS DECLARED:  EN55011; EN50082-1;
EN61010-1 (EMC for industrial, scientific, medical equipment; EMC for

generic immunity; compliance to low-voltage directive respectively)

TYPE OF EQUIPMENT: Scientific Equipment (for Laboratories)

MODEL NUMBER:   PTC-200

YEARS OF MANUFACTURE:  1997 and onward

         MJ RESEARCH INC, as manufacturer of the equipment described above, certifies that this
model has been tested and conforms to the applicable Directives and Standards of the
European Union (EU) as described above.  Test data to verify this conformity are available
for inspection at either MJ RESEARCH, INC. or Finnzymes Oy, at the addresses listed below.
The instrument in question carries the “CE” mark on the nameplate.

 MANUFACTURER’S OFFICIAL:

Robert A Iovanni
Senior Electrical Engineer

MJ RESEARCH, INC.
590 Lincoln Street

Waltham, Massachusetts 02451
UNITED STATES OF AMERICA

Tel:  (617) 923-8000
Fax:  (617) 923-8080

            Date:           8/5/99



DECLARATION OF CONFORMITY

MJ RESEARCH, INC. hereby declares that the MJ RESEARCH PTC-225 DNA Engine
Tetrad™ thermal cycling system conforms to the following directives and standards:

APPLICATION OF COUNCIL DIRECTIVES:  89/336/EEC

STANDARDS TO WHICH CONFORMITY IS DECLARED:  EN55011 & EN50082-1
 (EMC for industrial, scientific, medical equipment & EMC for generic immunity)

TYPE OF EQUIPMENT: Scientific Equipment (for Laboratories)

MODEL NUMBER:   PTC-225 System
(which includes one PTC-225 base unit, four PTC-200/225 “Alpha”

sample-block/heat-pump subassemblies, and one AT&T #RM2000 Power Supply)

YEAR OF MANUFACTURE:  1996

         MJ RESEARCH INC, as manufacturer of the system described above, certifies that this
model has been tested and conforms to the applicable Directives and Standards of the
European Union (EU) as described above.  Test data to verify this conformity are avail-
able for inspection at either MJ RESEARCH, INC. or Finnzymes Oy, at the addresses listed
below.  The instrument in question carries the “CE96” mark on the nameplate.

MANUFACTURER’S OFFICIAL:

Robert A Iovanni
Senior Electrical Engineer

MJ RESEARCH, INC.
590 Lincoln Street

Waltham, Massachusetts 02451
UNITED STATES OF AMERICA

Tel:  (617) 923-8000
Fax:  (617) 923-8080

 Date:           8/5/99
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MJ RESEARCH, INC.

Manufactory
590 Lincoln Street
Waltham, Massachusetts  02451  USA

Product Information:
Cust. service & support:

General fax:

(888) 735-8437
(888) 652-9253
(617) 923-8080

Web site: www.mjr.com

Distributors Worldwide

National Sales Office
987 Tahoe Blvd. #106
Incline Village, Nevada  89451

All orders: (888) 729-2165


